# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About This Guide</td>
<td>9</td>
</tr>
<tr>
<td>Intended Audience for This Guide</td>
<td>10</td>
</tr>
<tr>
<td>Related Documents</td>
<td>10</td>
</tr>
<tr>
<td>Conventions Used in This Guide</td>
<td>11</td>
</tr>
<tr>
<td>Standard Conventions</td>
<td>11</td>
</tr>
<tr>
<td>Information Icons</td>
<td>12</td>
</tr>
<tr>
<td>If You Need Help</td>
<td>13</td>
</tr>
<tr>
<td>Before You Contact Technical Support</td>
<td>13</td>
</tr>
<tr>
<td>Contacting Technical Support</td>
<td>14</td>
</tr>
<tr>
<td>Verint Witness Actionable Solutions Website and the Customer Interaction Center (CIC)</td>
<td>14</td>
</tr>
<tr>
<td>Telephone</td>
<td>14</td>
</tr>
<tr>
<td>Email</td>
<td>15</td>
</tr>
<tr>
<td>Direct Internet FTP</td>
<td>15</td>
</tr>
<tr>
<td>Other Support and Training Alternatives</td>
<td>15</td>
</tr>
<tr>
<td>1 Introducing Content Producer</td>
<td>16</td>
</tr>
<tr>
<td>Overview</td>
<td>17</td>
</tr>
<tr>
<td>Key features</td>
<td>17</td>
</tr>
<tr>
<td>Content Producer Components</td>
<td>18</td>
</tr>
<tr>
<td>2 Getting Started and Navigation</td>
<td>19</td>
</tr>
<tr>
<td>Launching Content Producer Author</td>
<td>20</td>
</tr>
<tr>
<td>Using the menu bar on the Welcome window</td>
<td>20</td>
</tr>
<tr>
<td>Using Function Links in the Left Panel of the Welcome Window</td>
<td>21</td>
</tr>
<tr>
<td>Actions</td>
<td>21</td>
</tr>
<tr>
<td>Recent Files</td>
<td>21</td>
</tr>
<tr>
<td>Help</td>
<td>21</td>
</tr>
<tr>
<td>To exit the program</td>
<td>22</td>
</tr>
<tr>
<td>Launching Content Producer Editor</td>
<td>22</td>
</tr>
<tr>
<td>Using the menu bar</td>
<td>23</td>
</tr>
<tr>
<td>To use the toolbar</td>
<td>23</td>
</tr>
<tr>
<td>The Frame view</td>
<td>23</td>
</tr>
<tr>
<td>To work with Playback and Slide controls, and the Movie Timeline</td>
<td>23</td>
</tr>
<tr>
<td>To use the Create New Project dialog</td>
<td>23</td>
</tr>
<tr>
<td>To start a project</td>
<td>24</td>
</tr>
<tr>
<td>To exit the program</td>
<td>24</td>
</tr>
</tbody>
</table>
3 Creating and Navigating in Clip Projects .................................................. 25
   Opening Existing Clip Projects ................................................................. 26
      Opening a Clip project from a folder ...................................................... 26
      Opening a Clip project in Content Producer Author ................................. 26
   Creating Screenshot Projects .................................................................... 27
      1. Selecting a Screenshot Project Size and Type ....................................... 27
      2. Selecting Your Screenshot Capture Mode ............................................. 31
      3. Capturing Screenshots. ....................................................................... 33
         Selecting the screen area before beginning the screenshot capture process for a Custom,
         Standard or Area screenshot type ......................................................... 34
         Selecting the window area before beginning the screenshot capture process .... 36
         Capturing a screenshot ....................................................................... 37
   Creating Quiz Projects. ............................................................................... 39
   Creating a Quiz Project. ............................................................................. 39
   Creating Image Projects ........................................................................... 44
   Creating an Image Project ......................................................................... 44
   Creating Blank Projects ........................................................................... 48
   Creating a Blank Project ........................................................................... 48
Working in a Project Window ....................................................................... 51
   Navigating in a Project Window .................................................................. 51
      The Menu Bar .......................................................................................... 52
      The Project Toolbar .................................................................................. 53
   Working With Project Views. ..................................................................... 55
      Opening the Thumbnails, Stylesheets, and/or Browser view on the Left Panel .. 55
      Viewing a selected slide only ................................................................... 57
   Viewing and Working with a Thumbnails View Only ...................................... 57
      Opening the Thumbnail view only ............................................................. 58
      Moving slides in Thumbnail View. ............................................................. 58
      Embedding a background color or image on one or more slides ................. 59
      Hiding/showing slides in Thumbnail View. ............................................... 59
      Duplicating Slides in Thumbnail View ....................................................... 59
   Viewing and Working in Stylesheets View Only .......................................... 60
      Opening the Stylesheets view only ........................................................... 60
      Modifying Existing Stylesheets ............................................................... 61
   Inserting or Importing Slides to your Clip Project ...................................... 62
   Inserting a screenshot slide ....................................................................... 62
   Inserting a quiz slide. ............................................................................... 62
   Inserting an image slide ............................................................................ 63
   Inserting a blank slide ............................................................................... 63
   Importing Slides from other clip projects .................................................... 64

4 Adding Illustrative Objects to Slides ......................................................... 66
   About Objects on Slides ............................................................................ 67
   Tools Palette Overview .............................................................................. 68
   Using note, balloon and text tools .............................................................. 69
   When to use a note, balloon or text frame. ................................................... 69
      Notes ...................................................................................................... 69
      Balloons ................................................................................................. 69
Attaching Events to Slides and Slide Objects ................................................. 88
Attaching an Event to a Slide or Slide Object ................................................. 88
Modifying Event Actions Attached to Slides and Slide Objects ................. 94
Deleting Event Actions Attached to Slides and Slide Objects ................. 94
Adding Hyperlinks to Selected Text ............................................................... 94
Attaching Audio to Slides or Slide Objects .................................................. 96
Attaching Audio to a Slide or Slide Object .................................................. 96
Setting the Default Delay for Recording Sound ............................................. 97
Deleting Sound Attached to a Slide or Object .............................................. 98
Adding Movies to Slides ................................................................................ 99
Adding a Movie to a Slide ............................................................................ 99
Attaching Rollover Areas to Slide Objects ................................................... 101
Attaching a Rollover Area to a Slide Object ................................................. 101
Adding Buttons to Slides .............................................................................. 103
Inserting a Button on a Slide ....................................................................... 103
Selecting a Button Style .............................................................................. 104
Inserting Text on a Button ......................................................................... 104
Attaching an Action to a Button ................................................................ 105
Working with the cursor ............................................................................. 106
Showing/hiding the cursor ........................................................................... 106
Modifying the cursor path on a slide ........................................................... 107
  Modifying the cursor path without changing where the path begins ........ 107
  Modifying the cursor path and change where the path begins ................. 107
  Moving the cursor path to the same place on the previous or the next slide 107
Adding and Locking Points on a Cursor Path ............................................. 108
Changing Cursor Appearance .................................................................... 109
Changing a Cursor’s Shape ....................................................................... 109
Changing a Cursor’s Path Movement ............................................................ 109
Adding a Click Sound to the Cursor ............................................................ 110

6  Working With Interactive Zones ................................................................. 111
About Interactive Zones ............................................................................. 112
Interactive Zone Types ............................................................................ 112
Attaching Features to Zones .................................................................. 113
Inserting Interactive Zones on Slides ......................................................... 114
Adding a Pause Zone ................................................................................ 115
Adding a Click Zone ................................................................................ 116
Adding a Text Zone ................................................................................ 118
Adding a Keystroke Zone ........................................................................ 120
Adding Question Zones ........................................................................... 122
  Adding a question zone: ........................................................................ 122
  Working with different question types: ................................................. 123
  Modifying Question zones .................................................................... 128
Configuring Correct/Incomplete/Incorrect Messages ................................ 130
Changing Default Interactive Zone Events ............................................... 130
Changing Message Wording .................................................................... 132
Changing the Message Background Color ............................................... 132
Moving Message Boxes ........................................................................... 133
### Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resizing Message Boxes</td>
<td>133</td>
</tr>
<tr>
<td>Setting Scoring Options for Interactive Zones</td>
<td>134</td>
</tr>
<tr>
<td>Changing the number of points assigned to an action or question in an interactive zone</td>
<td>134</td>
</tr>
<tr>
<td>Changing the number of attempts a user is allowed to complete an action or a question</td>
<td>135</td>
</tr>
<tr>
<td>Changing the duration allowed for a user to complete an action or a question</td>
<td>135</td>
</tr>
<tr>
<td>Modifying zones</td>
<td>136</td>
</tr>
<tr>
<td>Moving a zone area/object</td>
<td>136</td>
</tr>
<tr>
<td>Resizing a zone area</td>
<td>136</td>
</tr>
<tr>
<td>Deleting a zone</td>
<td>136</td>
</tr>
<tr>
<td><strong>7 Using Content Producer Editor</strong></td>
<td>137</td>
</tr>
<tr>
<td>About Editor</td>
<td>138</td>
</tr>
<tr>
<td>Starting Content Producer Editor</td>
<td>139</td>
</tr>
<tr>
<td>Toolbar overview</td>
<td>139</td>
</tr>
<tr>
<td>Opening existing audio/video media files</td>
<td>141</td>
</tr>
<tr>
<td>Importing an audio/video media file</td>
<td>141</td>
</tr>
<tr>
<td>Recording an audio/video session</td>
<td>143</td>
</tr>
<tr>
<td>Setting your recording options</td>
<td>143</td>
</tr>
<tr>
<td>To select a video and/or audio capture option</td>
<td>143</td>
</tr>
<tr>
<td>To select an image source option</td>
<td>144</td>
</tr>
<tr>
<td>To select an audio source option</td>
<td>144</td>
</tr>
<tr>
<td>To set a file destination for the recording</td>
<td>144</td>
</tr>
<tr>
<td>Recording a video clip</td>
<td>146</td>
</tr>
<tr>
<td>Saving audio/video media files</td>
<td>149</td>
</tr>
<tr>
<td>Saving audio/video files</td>
<td>149</td>
</tr>
<tr>
<td>Saving an audio/video media file as an audio file only</td>
<td>149</td>
</tr>
<tr>
<td>Creating Slides in Editor</td>
<td>150</td>
</tr>
<tr>
<td>About Playback, Slide and Movie Timeline controls</td>
<td>150</td>
</tr>
<tr>
<td>Playing a video clip</td>
<td>153</td>
</tr>
<tr>
<td>Navigating between frames</td>
<td>153</td>
</tr>
<tr>
<td>Compressing or expand the Movie Timeline</td>
<td>153</td>
</tr>
<tr>
<td>Creating a slide</td>
<td>153</td>
</tr>
<tr>
<td>Creating and insert a slide</td>
<td>154</td>
</tr>
<tr>
<td>Navigating between slides</td>
<td>154</td>
</tr>
<tr>
<td>Previewing a slide</td>
<td>154</td>
</tr>
<tr>
<td>Removing a slide</td>
<td>154</td>
</tr>
<tr>
<td>Exporting slides to Content Producer Author</td>
<td>155</td>
</tr>
<tr>
<td><strong>8 Managing Clip Projects</strong></td>
<td>156</td>
</tr>
<tr>
<td>About Managing Clip Projects</td>
<td>157</td>
</tr>
<tr>
<td>Managing Clip Files</td>
<td>157</td>
</tr>
<tr>
<td>Source files</td>
<td>157</td>
</tr>
<tr>
<td>Compiled clip folder &amp; files</td>
<td>157</td>
</tr>
<tr>
<td>Adding Clips to a web site</td>
<td>159</td>
</tr>
<tr>
<td>Files to Upload to the Web Server</td>
<td>159</td>
</tr>
<tr>
<td>Exporting Slides and Audio</td>
<td>160</td>
</tr>
<tr>
<td>Exporting Slides as Image Files</td>
<td>160</td>
</tr>
<tr>
<td>Exporting Slides to an Adobe Acrobat PDF File</td>
<td>161</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Exporting Audio</td>
<td>161</td>
</tr>
<tr>
<td>Printing Slides</td>
<td>162</td>
</tr>
<tr>
<td>Setting the page layout</td>
<td>163</td>
</tr>
<tr>
<td>Publishing Clip Projects</td>
<td>164</td>
</tr>
<tr>
<td>About Publishing Clips</td>
<td>165</td>
</tr>
<tr>
<td>Configuring Clip Project Properties</td>
<td>166</td>
</tr>
<tr>
<td>Opening the Project Properties Dialog Box</td>
<td>166</td>
</tr>
<tr>
<td>Setting Project Properties options</td>
<td>167</td>
</tr>
<tr>
<td>Entering title, author and company information</td>
<td>167</td>
</tr>
<tr>
<td>Selecting sound and image quality options</td>
<td>168</td>
</tr>
<tr>
<td>Setting timing options</td>
<td>169</td>
</tr>
<tr>
<td>Setting clip options</td>
<td>170</td>
</tr>
<tr>
<td>Setting packaging options</td>
<td>171</td>
</tr>
<tr>
<td>Setting Language options for the clip</td>
<td>173</td>
</tr>
<tr>
<td>Setting Flash options</td>
<td>174</td>
</tr>
<tr>
<td>Selecting a ClipSkin</td>
<td>175</td>
</tr>
<tr>
<td>Editing a clip’s HTML page</td>
<td>176</td>
</tr>
<tr>
<td>Previewing a Clip</td>
<td>177</td>
</tr>
<tr>
<td>Publishing a Clip</td>
<td>178</td>
</tr>
<tr>
<td>Uploading Content to eLearning Lesson Management</td>
<td>182</td>
</tr>
<tr>
<td>Uploading Lesson Content to the eLearning Lesson Management System</td>
<td>183</td>
</tr>
<tr>
<td>Selecting the AICC Learning Management System reporting option in Content Producer Author</td>
<td>184</td>
</tr>
<tr>
<td>Uploading Clips to the eLearning Lesson Management System</td>
<td>185</td>
</tr>
<tr>
<td>Starting eLearning</td>
<td>185</td>
</tr>
<tr>
<td>Configuring Lesson Settings</td>
<td>185</td>
</tr>
<tr>
<td>Uploading lesson content</td>
<td>186</td>
</tr>
<tr>
<td>Student Procedures</td>
<td>188</td>
</tr>
<tr>
<td>Starting eLearning Student</td>
<td>188</td>
</tr>
<tr>
<td>Taking a lesson</td>
<td>188</td>
</tr>
</tbody>
</table>
The *Content Producer User Guide* describes how to use the Content Producer application to create slides and clips for use as training material that can be used with eLearning systems in your organization.

This introductory section to the guide describes the following topics:

- [Intended Audience for This Guide, page 10](#)
- [Related Documents, page 10](#)
- [Conventions Used in This Guide, page 11](#)
- [If You Need Help, page 13](#)
- [Contacting Technical Support, page 14](#)
Intended Audience for This Guide

This guide is designed to be used by:

- Instructional Content developers
- Managers and supervisors.
- eLearning Administrators

Related Documents

The following documents are referenced in this document:

- **Content Producer Installation/Upgrade Guide**
  You can download this guide from Content Producer Help and Support site at http://producerservices.verint.com/.

- **eLearning Administration User Guide**

- **eLearning Student User Guide**
  These guides are available on the Witness Actionable Solution packages’ installation DVDs, which also include the licensing key for Content Producer.
Conventions Used in This Guide

The following two tables describe some of the conventions that are used in this document:
- The Standard Conventions table highlights conventions used to describe user interaction, as well as special notations.
- The Information Icons table describes the icons used to highlight information of special interest to the user.

Standard Conventions

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Items</td>
<td>Menu items are highlighted in bold as in the following example: From the menu, choose <strong>File &gt; Preferences &gt; Options</strong>.</td>
</tr>
<tr>
<td>Document Names</td>
<td>Other Verint Systems documents are referred to using italics. For example: Refer to the <em>Workforce Optimization Suite Installation Guide</em> for more information.</td>
</tr>
<tr>
<td>Buttons, Functions, and Dialog Box and Window Names</td>
<td>Specific button or function names are highlighted in bold. The following example shows how a button and dialog name are referred to in the documentation: Click <strong>OK</strong>, and then choose the <strong>Restore Database</strong> dialog box.</td>
</tr>
<tr>
<td>User Variables</td>
<td>When the user is expected to type a value, the name of the variable to be replaced is surrounded by &lt; &gt;. The following are examples:</td>
</tr>
<tr>
<td></td>
<td><code>&lt;Your ER Server Name&gt;</code></td>
</tr>
<tr>
<td></td>
<td>The notation <code>&lt;Your ER Server Name&gt;</code> refers to the name of your Enterprise Reporting server.</td>
</tr>
<tr>
<td></td>
<td>When you see this notation, replace it with the actual name of your Enterprise Reporting server.</td>
</tr>
</tbody>
</table>
# Information Icons

<table>
<thead>
<tr>
<th>Icon Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Important details that we want to make sure that you do not overlook.</td>
</tr>
<tr>
<td>Tip</td>
<td>Helpful hints that can improve the efficiency or effectiveness of your work.</td>
</tr>
<tr>
<td>Caution</td>
<td>Advice that can help you avoid undesirable results.</td>
</tr>
</tbody>
</table>
| Warning   | Situations that can result in:  
  1. Harm to software  
  1. Loss of data  
  1. An interruption in service |
If You Need Help

Our goal at Verint Systems is to provide you with the best products backed by a high quality support network with a variety of resource options. These include:

- Verint Systems website and Customer Interaction Center (CIC)
- Telephone
- E-mail
- Direct Internet FTP
- Other support and training alternatives

Before You Contact Technical Support

Help from Technical Support is as near as your keyboard or telephone. However, before you contact us, read this section carefully. We can provide faster and better service if you have certain information available when you contact us.

You can solve many problems quickly with the information in the online Help system or in this manual. When running the product, you can select the Help button in the upper-right portion of the window to get help for the active window or dialog box.

If you are unable to solve a problem by using the online Help or this manual, and you need help from Technical Support, use the guidelines in the following checklist before you contact us:

1. Write down the problem and details that may help us solve the problem. If you can consistently reproduce the problem, list the steps to reproduce it.

2. Have at least the following information available when you contact Technical Support.
   - Your name and customer site number, and identify yourself as a customer, Verint Systems partner, or Verint Systems employee. Customer-initiated CIC contact is restricted to customers that are one of the designated support contacts on your company’s service level agreement.
   - Product name and version number.
   - Server and client operating systems and service pack version numbers
   - Supporting files and screenshots (if available)
   - ACD type and reporting package (for ACD-related issues)
   - The wording of any error messages from the product and/or operating system
   - Has this problem occurred previously? If it is new, did you change your system configuration recently?
Contacting Technical Support

Once you have determined that you need technical support, and you have gathered as much information as you can based on the checklist, the following provides a list of the various support options and alternatives:

Verint Witness Actionable Solutions Website and the Customer Interaction Center (CIC)

This facility allows users worldwide fast access to product information, marketing and sales information, information about the company, technical documentation, support case management, and support solutions information.

You can access the Verint Witness Actionable Solutions Customer Interaction Center (CIC) support site at www.witness.com/support, or through www.witness.com by clicking the Support Login link from the Home page.

Once you have successfully logged on to the CIC, use the navigation tree on the right to access available user manuals, troubleshooting guides, FAQs, and more.

For help using the site, refer to the CIC Support Website Navigation Guide. To access this document, click the link at the right on the CIC Home page. The guide is a PDF file that you can save or print locally for future reference.

Telephone

Verint Systems’ Customer Interaction Center (CIC) provides the self-service tools and information you need to get the most out of your investment.

**Americas:**
+1 800 4 WITNESS (USA toll-free)
+1 770 754 1870

**Europe/Middle East/Africa:**
+ (0) 845 843 7333

**Hong Kong/Asia Pacific:**
+852 8103 0104

**Australia:**
1 800 600 806

**New Zealand:**
+61 2 8223 9493

**Japan:**
+81 (0)3 5919 1875

For geographic locations and hours of operation, refer to www.witness.com/support and click on Contact Centers.
Email

If you are a new customer and need a logon ID and password, you can e-mail support@witness.com to obtain your new logon information.

Direct Internet FTP

This facility greatly speeds up transfer of new and upgraded software to all Verint Systems customers. Contact us for more information about access to Direct Internet FTP services.

Other Support and Training Alternatives

In addition to documentation, online Help, and support services, Verint Systems also offers both classroom-based and online learning alternatives to suit your specific needs. Contact us for more information about other support and training alternatives.
Welcome to Content Producer—the quick, powerful way to design multimedia demonstrations in the form of audio/video Clips you can develop in a short period of time.

You can incorporate Content Producer into your workplace, as part of your Impact 360 enterprise solution, in a number of ways:

- Create informative clips to illustrate best practices for your customer interaction center.
- Use authoring and editing tools to design interactive eLearning modules to meet professional development/customer service objectives.
- Develop simulations and tutorials that enable your audience to achieve specific training goals and increase productivity.

This chapter describes the following topics:

- Overview, page 17
- Key features, page 17
- Content Producer Components, page 18
Overview

Content Producer is comprised of authoring, editing, and conversion tools to develop learning clips that engage your audience and provide educational information about a specific topic.

Content Producer can be used either as a standalone product or as a power feature in the Learning module of the Impact 360 suite.

If you use Content Producer with the Impact 360 suite, you can create Clips from recorded segments of customer interactions in such applications as Quality Monitoring 10 SP3 or later, Quality Monitoring Quality Monitoring 7.8 SP1 or later, ContactStore, or ContactStore Plus. You can then deliver the learning clips via the eLearning Lesson Management system.

Key features

Content Producer offers many features, including the following:

**Recording features in Content Producer Editor**

You can capture a video or audio track (in AVI or WAV format) from your workstation, modify it in Content Producer Editor, and export it to Content Producer Author as slides. In Author, you can edit the slides, add additional screen captures to complement the audio recordings, and more.

**Quality Monitoring 10 SP3 or later, Quality Monitoring 7.8 SP1 or later, ContactStore, and ContactStore Plus contact files**

Using Content Producer Editor, you can create interactive, low- bandwidth training Clips, using customer interactions recorded in all Impact 360 recording and playback engines.

Quality Monitoring 10 SP3 or later and Quality Monitoring 7.8 SP1 or later each includes a utility that can convert contact files into appropriate AVI or WAV files. These files can then be opened in Content Producer Editor.

**Screenshot projects**

You can capture screenshots from a target application, using Full Screen or Screen Area mode, to create clips to use as simulations that illustrate how to perform a specific task.

**Image projects**

You can create clips directly from a set of image files without taking screenshots. You can select multiple image files simultaneously and scale them to fit as background images on slides.
**Interactive learning**

You can create an interactive quiz project, either to insert at the end of a clip containing a lesson, or as a standalone project. Quiz projects can contain questions in a variety of formats, depending on how you want students to respond to questions, such as true or false interactive quizzes, multiple choice quizzes, and so on.

**Clip management**

You can send clips via e-mail, distribute them as hyperlinks to your web site, or deliver them through your eLearning Lesson Management system.

**Check for automatic updates**

You can configure your system to check for automatic updates for Content Producer on a regular basis, and you can select the **Check for Updates** option from the Help menu in Content Producer Author to do so at any time.

---

### Content Producer Components

Content Producer has two components:

- **Content Producer Author**
  You use this component to create/publish clips.

- **Content Producer Editor**
  You use this component to import/record audio or video contact files from any Quality Monitoring 10 SP3 or later, Quality Monitoring 7.8 SP1 or later, or Impact 360 suite recording and playback engine or any source of WAV or AVI files.

For more details, see your **Content Producer Installation and Upgrade Guide**. This guide describes system requirements, as well as how to install, register, check for updates, and upgrade your licensed Content Producer program. This guide is available on DVD in your product package, and can also be found at this Web address:

[http://producerservices.verint.com](http://producerservices.verint.com)
Getting Started and Navigation

Content Producer comprises two main components, Content Producer Author and Content Producer Editor.

- Author allows you to create and compile clips for your eLearning content using captured screenshots and imported images.
- Editor allows you to import/record audio or video contact files from Quality Monitoring 10 SP3 or later, Quality Monitoring 7.8 SP1, or the Impact 360 recording and playback engine.

This chapter describes how to get started using Content Producer Author and Content Producer Editor.

- Launching Content Producer Author, page 20
- Launching Content Producer Editor, page 22
Launching Content Producer Author

1. Click **Start** on your Windows task bar and select **Programs > Verint Content Producer > Content Producer Author**. The **Content Producer Author** Welcome window opens.

Using the menu bar on the Welcome window

The menu bar across the top of the window includes the **File, Edit, View,** and **Help** menus to enable you to manage and edit your clip project:

- From the **File** menu, you open, save, close clip projects, and print, import and export files.
- From the **Edit** menu, you copy, cut, and paste items in your Clip projects, as well as set preferences.
- From the **View** menu, you select views for your screen, such as a Stylesheet view, Thumbnail view, Timeline, and more. These views appear in the panel adjacent to any slide that belongs to a clip.
- The **Help** menus provide links to Verint Systems’ data storehouse of information about Content Producer Author.
Using Function Links in the Left Panel of the Welcome Window

**Actions**

Under **Actions**, click one of the following links:

- **New Project** to begin a new clip project. The **Create New Project** window opens, and provides the options available for creating new slides for your presentation. For details, see Chapter 3, Creating and Navigating in Clip Projects on page 25.

- **Open Project** to find and retrieve a project you previously saved, and edit the project as required. For details, see Chapter 5, Adding Dynamic Elements to Slides on page 85.

- **Check for Updates** to check for updates to Content Producer, and click one of the following update options:
  - the **Content Producer automatically checks for updates** option. With this option, you choose how often you want Content Producer to check for updates (for example, **Weekly**).
  - the **Manually checks for updates** option. When selected, you can check for Content Producer updates right away.

  For more information about the **Check for Updates** feature, see the **Content Producer Installation and Upgrade Guide**.

**Recent Files**

Under **Recent Files**, retrieve a recently opened clip file by clicking its name on the list.

**Help**

Under **Help**, click one of these links:

- **Content Producer Help**, to be redirected to the Content Producer Help and Support site. The Help and Support site also contains downloadable versions of this guide and the **Content Producer Installation and Upgrade Guide**.

- **User Guide**, to open this Content Producer User Guide.

- **Licence Activation**, to activate your license using the license key you received with your Impact 360 product package.

  For more information about license activation, see the **Content Producer Installation and Upgrade Guide**.
To exit the program

- To close the program, select **File>Exit**. The window closes and you return to the desktop.
- To close a project you are working on without exiting the program, select **File>Close**. You return to the main Content Producer Author window shown above.

Launching Content Producer Editor

1. Click **Start** on your Windows task bar and select **Programs > Verint Content Producer > Content Producer Editor**. The Content Producer Editor window opens:
Using the menu bar

The menu bar contains five menus - File, Edit, View, Services and Help - to enable you to manage and edit the audio/video project you imported or created:

- From the File menu, you open and save projects, select or capture media for projects, or export audio/video media as slides to Content Producer Author.
- From the Edit menu, you play and pause the media you’ve imported into Content Producer Editor, as well as preview, insert and remove slides that you’ve selected.
- From the View menu, you activate the toolbar and the Status and Player bars. You can also adjust zoom settings.
- The Services and Help menus provide links to information about Content Producer Editor.

To use the toolbar

The toolbar provides shortcuts to saving or opening files, capturing or selecting media for projects, and more.

For details on using the toolbar, see Chapter 7, Using Content Producer Editor on page 137.

The Frame view

The Frame view displays the current frame selected on the Movie Timeline.

To work with Playback and Slide controls, and the Movie Timeline

Playback controls allow you to move through the Movie Timeline.
Slide controls help you add, remove and navigate through slides on the Movie Timeline
The Movie Timeline shows the progress of the audio/video clip as it moves from frame to frame. Timeline control buttons - Zoom Timeline In and Zoom Timeline Out - changes the timeline display.

For more information on these controls, see About Playback, Slide and Movie Timeline controls on page 150.

To use the Create New Project dialog

This dialog displays the first time you start Content Producer Editor.
Until you click Cancel to close the dialog, or select an option to select or capture media, the rest of the Editor main screen is inactive.
To remove the dialog and not have it appear the next time you open Editor, select the Don’t show this window again check box.
To start a project

- To import an existing audio/video media file (*.AVI, *.WAV), click **Select Media** on the toolbar.
- To record a media segment from an application running on your computer, click **Capture Media** on the toolbar.

For details about using Content Producer Editor, see **Chapter 7, Using Content Producer Editor** on page 137.

To exit the program

- To close the application, select **File > Exit**. The window closes and you return to the desktop.
- To close the file you’ve been working on but not exit the program, select **File > New Project**.
This chapter describes how to use Content Producer Author to create the four project types (Screenshot, Quiz, Images, and Blank), how to use project views such as the Thumbnail view and the Stylesheet View, and how to insert new slides and images once you have finished a project.

This chapter comprises the following sections:

- Opening Existing Clip Projects, page 26
- Creating Screenshot Projects, page 27
- Creating Quiz Projects, page 39
- Creating Image Projects, page 44
- Creating Blank Projects, page 48
- Working in a Project Window, page 51
- Inserting or Importing Slides to your Clip Project, page 62
Opening Existing Clip Projects

You can open Clip projects already saved on your computer in order to edit the slides and updating the Clip. You can open a clip in one of these two ways:

Opening a Clip project from a folder

1. Navigate to the folder that contains the Clip project you want to open.
2. Double-click the file with the *.qvp extension. Content Producer starts, and the selected clip project opens.

Opening a Clip project in Content Producer Author

1. Start Content Producer Author to open the main window.
2. In the left panel, in the Actions list, click Open Project.
3. In Open File window, locate and select your project file, then click Open.

Once you open your clip project using one of the two methods described above, the first slide belonging to the clip project open in the right panel, and the view selected the last time Content Producer was opened (such as Thumbnails or Stylesheets), open on the right panel.

You are now ready to modify the window view (for example, closing the Thumbnail panel, and opening the Stylesheets panel), edit the slides in the project, add annotations, insert other slides (such as quiz slides), and more.

See:

- Working With Project Views on page 55, for details on working with a thumbnails view.
- Viewing and Working in Stylesheets View Only on page 60, for details on working with the stylesheets view.
- Chapter 4, Adding Illustrative Objects to Slides, page 66 and Chapter 5, Adding Dynamic Elements to Slides, page 85, for details on adding text and other objects to a single slide.
- Chapter 6, Setting Scoring Options for Interactive Zones, page 134
- Chapter 9, Publishing Clip Projects, page 164, for details on adding text and other objects to a single slide.
Creating Screenshot Projects

You can create a new clip project using the Screenshot Project method. This method allows you to capture static screenshots of:

- a running target application
- a portion of your desktop screen
- a full desktop screen
- When creating a screenshot, you can also set the screenshot dimensions you want used in your screenshot project.

See:

- 1. Selecting a Screenshot Project Size and Type on page 27
- 2. Selecting Your Screenshot Capture Mode on page 31
- 3. Capturing Screenshots on page 33

1. Selecting a Screenshot Project Size and Type

1 Launch Content Producer Author. For details, see Chapter 2, Launching Content Producer Author, page 20.

2 If you plan to select:
   - a Custom, Standard, or Area screenshot type (see the table under Step 5 below), ensure that the window or screen in which you plan to capture the screenshot is already current and open.
   - a Window screenshot type (see the table under Step 5 below), ensure that the screen in which you want to select a window is already open.
   - the Application screenshot type (see the table in Step 5 below), ensure that the application is already launched.

3 In the Content Producer Author window, click New Project. The Create New Project window opens.
4 In the left panel of the window, click the **Screenshot Project** to display screenshot size and capture mode options:
Click the arrow beside the **Specify the slide size you would like to create or capture** box, select one of the following screenshot capture options, and complete the appropriate actions:

<table>
<thead>
<tr>
<th>Screenshot Capture Type</th>
<th>Actions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Custom</strong></td>
<td><strong>Specify a custom width and height</strong></td>
</tr>
<tr>
<td></td>
<td>If you select this option, the window refreshes with a <strong>Width</strong> box and a <strong>Height</strong> box below the <strong>Slide Size</strong> drop-down list:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Width and Height Selection" /></td>
</tr>
<tr>
<td></td>
<td>a. Select or type the width and height of the section of the window you want to capture.</td>
</tr>
<tr>
<td></td>
<td>b. Once you finish selecting your screenshot capture mode (see 2. Selecting Your Screenshot Capture Mode on page 31), you set the area of the screen, as described in Step Selecting the screen area before beginning the screenshot capture process for a Custom, Standard or Area screenshot type on page 34.</td>
</tr>
<tr>
<td><strong>Standard</strong></td>
<td><strong>Select a standard window size</strong></td>
</tr>
<tr>
<td></td>
<td>If you select this option, the window refreshes to with a drop-down list box below the <strong>Slide Size</strong> drop-down list, as well as tools to modify standard sizes:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Standard Window Size Selection" /></td>
</tr>
<tr>
<td></td>
<td>a. Click the arrow beside the box, and select a window size, such as <strong>SVGA (Recommended) 800 x 600</strong>. This is the size at which you then capture the screenshot.</td>
</tr>
<tr>
<td></td>
<td>b. If you want to add a size to the list, click the green cross button, type a name for the new size, and then select or type the width and height dimensions.</td>
</tr>
<tr>
<td></td>
<td>c. To modify an existing size in the list, select the size, and then click the pencil icon. In the <strong>Standard Resolution</strong> dialog box, change the name and/or dimensions as require.</td>
</tr>
<tr>
<td></td>
<td>d. To delete an existing size, select the size, click the delete icon, and then click <strong>Yes</strong> at the message prompt.</td>
</tr>
<tr>
<td></td>
<td>e. Once you finish selecting your screenshot capture mode (see 2. Selecting Your Screenshot Capture Mode on page 31), you set the area of the screen, as described in Step Selecting the screen area before beginning the screenshot capture process for a Custom, Standard or Area screenshot type on page 34.</td>
</tr>
<tr>
<td>Screenshot Capture Type</td>
<td>Actions Required</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Application</td>
<td>Capture a running application window</td>
</tr>
<tr>
<td></td>
<td>If you select this screenshot option, you can capture any action you take within a chosen application. Make sure that the application you want to capture is running before beginning the screenshot project.</td>
</tr>
<tr>
<td></td>
<td>Once you select this option, the screen refreshes showing a drop-down list box showing the applications running on your system, and their sizes, as well as an option to resize the application window:</td>
</tr>
<tr>
<td></td>
<td>a. Click the arrow beside the box, and select the application for which you want to take screenshots.</td>
</tr>
<tr>
<td></td>
<td>b. If you want to resize the application window for your screen capture, check the Resize Application to: box to enable the adjacent 800 x 600 button.</td>
</tr>
<tr>
<td></td>
<td>c. Click the 800 x 600 button to open the Application Size dialog box. The default window size is 800 x 600 pixels.</td>
</tr>
<tr>
<td></td>
<td>d. From the list box, select either the Custom or the Standards option, and then select the appropriate sizes for your application window. Click OK when done.</td>
</tr>
<tr>
<td>Area</td>
<td>Capture an area of the screen</td>
</tr>
<tr>
<td></td>
<td>If you select this option, and once you finish selecting your screenshot capture mode (see 2. Selecting Your Screenshot Capture Mode on page 31), you set the area of the screen to be used in the screenshots, as described in Step Selecting the screen area before beginning the screenshot capture process for a Custom, Standard or Area screenshot type on page 34.</td>
</tr>
</tbody>
</table>
Chapter 3 - Creating and Navigating in Clip Projects

Creating Screenshot Projects

2. Selecting Your Screenshot Capture Mode

Content Producer provides two screenshot capture modes: Smart Capture and Manual Capture.

**Smart Capture Mode**

When you use the Smart Capture mode, you automatically take screenshots every time you perform an action inside the window or screen that you are capturing. Actions can include opening file menus inside an application, launching an application, typing text, and so on.

**Manual Capture Mode**

When you use the Manual Capture mode, you must first configure one or more ‘hotkeys’ in Content Producer. When you take a screenshot, you click the hotkey you

---

**Screenshot Capture Type**

<table>
<thead>
<tr>
<th>Capture Type</th>
<th>Actions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Select a window to capture</td>
</tr>
<tr>
<td></td>
<td>If you select this option, and once you finish selecting your screenshot capture mode (see 2. Selecting Your Screenshot Capture Mode on page 31), you select the area on the window currently open on your desktop that you want to capture, as described in Step Selecting the window area before beginning the screenshot capture process on page 36.</td>
</tr>
<tr>
<td>Full Screen</td>
<td>Capture the entire screen</td>
</tr>
<tr>
<td></td>
<td>With this option, you can capture any action you take on your screen. For example, you can switch from application to application, open new windows, close others - all of these actions are captured in the screenshot session.</td>
</tr>
<tr>
<td></td>
<td>Once you select this option, the screen refreshes and the Resolution Size list box appears below the Slide Size drop-down list:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Resolution Size List Box" /></td>
</tr>
<tr>
<td></td>
<td>a. Click the arrow beside the box, and select the screen resolution at which you want to capture your screenshot.</td>
</tr>
<tr>
<td></td>
<td>b. In general, you should pick a lower screen resolution for the screenshot than the resolution at which your own desktop screen is set. For example, if your window resolution is 1280 x 800 pixels, select a lower resolution from the Resolution Size list box. This ensures that when the clip is compiled with your screenshots, the clip can run full-size on smaller screens and/or lower resolutions. Frequently a resolution of 800 x 600 works well for most user screens.</td>
</tr>
<tr>
<td></td>
<td>c. Go to Step 4 to determine your screen capture mode.</td>
</tr>
</tbody>
</table>
selected to take the screenshot. With this screenshot capture mode, you can select exactly which screens you want to capture.

See:
- To select a screenshot capture mode: on page 32
- To set additional screenshot capture options that work with both the Smart Capture and Manual Capture modes on page 32

To select a screenshot capture mode:

1. In the **Capture Mode** area of the **New Screenshot Project window**, click the arrow beside the list box and select either the **Smart Capture** or **Manual Capture** option.

2. If you selected the **Manual Capture** option, you need to select a hotkey with which to capture screenshots. Click the **Options** button below the list box to open the **Capture Options** dialog box.

3. If you want to change the default **Capture Screenshot** hotkey (for example, **Ctrl**), in the dialog box, click the **Hotkeys** tab.

4. On the tab, click the button in the **Capture Screenshot** area. At the bottom of the dialog box, the words **Press any key** begin to flash. Click any key on keyboard that you want to use as your Content Producer screenshot capture hotkey.

5. Then click **OK** to close the dialog box.

6. Click **OK** to begin the screenshot capture process.

To set additional screenshot capture options that work with both the Smart Capture and Manual Capture modes
1 Click the **Options** button below the **Capture Mode** list box to open the **Capture Options** dialog box.

2 To select additional hotkey options for capturing animation frames, for pausing the screenshot capture process, for stopping the capture process, and for cancelling the capture process, click the **Hotkeys** tab, where you can change the default settings for the following hotkey options:
   - **Capture Animation Frame**
   - **Pause**
   - **Stop Capture**
   - **Cancel Capture**

   a. Click the button in one of the areas on the **Hotkeys** capture tab, for example, the button in the **Pause** area. At the bottom of the dialog box, the words **Press any key** begin to flash.

   b. Click any key on keyboard that you want to use as your Content Producer screenshot capture hotkey.

   These hotkeys function regardless of whether you select the **Smart Capture** or **Manual Capture** option.

3 To select feedback options, click the **Feedback** tab, and check the feedback option boxes. For example, in the **Play Sound** area, you can check the **On Screen Capture** box if you want to hear a clicking sound each time you capture a screenshot during a session (recommended).

4 To select options for how items are displayed on individual screenshots, click the **Generation** tab, and then check the boxes beside the display/audio options, such as the **Click Here Annotations** box in the **On Mouse Click - Add to Slide area**. You can also deselect the options you do not want to appear on a captured screenshot.

   For example, if you select **Click Here Annotations** option, an annotation with the message **Click here** appears in each screenshot captured that contains an action, inserted at the point where you performed the action on the screen. To capture pop-ups and tips on a screen, click the **Options** tab, and check the appropriate box(es).

5 To set the frame rate at which a screenshot is captured, and/or the screenshot delay, click the **Advanced** tab, and set the appropriate options.

6 Click **OK** when you are done.

7 Go to **3. Capturing Screenshots** on page 33 to begin capturing the screenshots you want to use in your Content Producer clip.

### 3. Capturing Screenshots

Depending on the screenshot type and size you selected in the procedure **1. Selecting a Screenshot Project Size and Type** on page 27, you may have to first select the screen area or window area for which you want to capture a screenshot.

See:
For Custom, Standard, or Area screenshot types, go to the following procedure:

Selecting the screen area before beginning the screenshot capture process for a Custom, Standard or Area screenshot type

For Window screenshot types, go to the following procedure:

Selecting the window area before beginning the screenshot capture process

For all screenshot types, you then capture screenshots using either the Smart Capture or Manual Capture mode.

See:

- Capturing a screenshot

Selecting the screen area before beginning the screenshot capture process for a Custom, Standard or Area screenshot type

1. If you selected a Custom, Standard or Area screenshot type and then selected the screen capture mode to use, your desktop screen refreshes and displays the screen that was current and open before you began your Content Producer project.

The screenshot area you specified is outlined with a dotted line, with handles you can use to change the dimensions of the area. Content Producer’s instruction on how to set the area you want to use for the screenshots is located at one corner of the screen.
Position your mouse pointer and click inside the outlined area and move the outline over the part of the screen that you wish to use in your screenshot. If necessary, use the handles to expand or shrink the dimension of the area for the screenshot.

Double click to begin your screenshot session. For details, see 3. Capturing Screenshots, page 33.
Selecting the window area before beginning the screenshot capture process

1. If you selected the Window screenshot type, and then selected the screen capture mode to use, your desktop screen refreshes and displays the window that was current and open before you began your Content Producer project.

A red square outlines the default window area, and an instruction note appears in one corner of the window.

2. To change the window area to capture, move your mouse over the area of the screen you want to capture, such as the menu bar, task bar or individual activity buttons.

The red outline moves to the window area you select, and only that area is captured as a screenshot.

3. Click the mouse when you are ready to begin your screenshot session.

For details, go to Capturing a screenshot on page 37.
Capturing a screenshot

Once you select a screenshot type and the screenshot capture mode, and, for Custom, Standard, Area, and Window screenshot types, you finish selecting an area, your screenshot session begins. During the session, the Content Producer Author screenshot session icon appears in your desktop task tray at the lower right corner of your screen:

To capture a screenshot

1. Depending on which screenshot capture mode you use (see 2. Selecting Your Screenshot Capture Mode on page 31), you capture screenshots in one of the following ways:
   - If you selected the Smart Capture mode, you capture a screenshot every time you make a change in the area that you are capturing.
   - If you selected the Manual Capture mode, click the Capture Screenshot hotkey you selected each time you want to take a screenshot.

   If you selected the On Screen Capture option for playback sounds (see To set additional screenshot capture options that work with both the Smart Capture and Manual Capture modes on page 32), you hear a clicking sound after you capture each screenshot.

2. When you have finished taking the screenshots you need, click the Screenshot Session icon in the desktop task tray. The Capture Status dialog box opens, and the screenshot session pauses.
3 Click **Stop** to end the screenshot session. The screen refreshes as the screenshots are created as slides in Content Producer Author. This process may take a few minutes.

When complete, the Content Producer Author window opens, displaying the first slide of the screenshot project.

4 You are now ready to modify the window view (for example, closing the **Thumbnail** panel on the left, and opening the **Stylesheets** panel), edit the slides, add annotations, insert other slides (such as quiz slides), and more.

See:
- [Navigating in a Project Window](#) on page 51
- [Working With Project Views](#) on page 55, for details on working with such views as Thumbnails and Stylesheets views.
- [Chapter 4, Adding Illustrative Objects to Slides, page 66](#) and [Chapter 5, Adding Dynamic Elements to Slides, page 85](#), for details on adding text and other objects to a single slide.
- [Chapter 9, Publishing Clip Projects, page 164](#), for details on adding text and other objects to a single slide.
Creating Quiz Projects

With Content Producer, you can create a variety of short answer and multiple choice quiz slides and assemble them in a quiz project. These slides can be compiled and published as standalone examinations, or can be used for insertion into other projects, for example into a clip for which you want to include quiz slides.

See:
- Creating a Quiz Project, page 39

Creating a Quiz Project

1. Launch Content Producer Author. For details, see Chapter 2, Launching Content Producer Author, page 20.

2. In the Content Producer Author window, click New Project. The Create New Project window opens.

3. In the left panel of the window, select Quiz Project. The right panel of the window refreshes to show quiz project options.
From the **Slide Size** list box, select a size for your quiz question slides, and select one of the two as described in the table below:

<table>
<thead>
<tr>
<th>Slide Size</th>
<th>Actions Required</th>
</tr>
</thead>
</table>
| Custom     | Specify a custom width and height  
If you select this option, the window refreshes with a **Width** box and a **Height** box below the **Slide Size** drop-down list:  
Select or type the width and height you want for the slides in your quiz slide project.  
**Tip:** If you are inserting quiz slides from this project into, for example, a screenshot project, make sure that you select the same dimensions for the quiz slides as you did for the screenshot slides. |
| Standard   | Select a standard window size  
If you select this option, the window refreshes to with a drop-down list box below the **Slide Size** drop-down list, as well as tools to modify standard sizes:  
- a. Click the arrow beside the box, and select a window size for the quiz slide, such as **SVGA (Recommended) 800 x 600**.  
- b. If you want to add a size to the list, click the green cross button, type a name for the new size, and then select or type the width and height dimensions.  
- c. To modify an existing size in the list, select the size, and then click the pencil icon. In the **Standard Resolution** dialog box, change the name and/or dimensions as required.  
- d. To delete an existing size, select the size, click the delete icon, and then click **Yes** at the message prompt. |
To add quiz slides to your project, in the **Quiz Questions** area, click the green cross button  beside the list box. The **Question** dialog box opens with a list of possible question types for your slides.

The table below describes all Content Producer Author question options:

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Short Answer - Fill in the Blank</td>
<td>A ‘fill in the blank’ question that has a single answer.</td>
</tr>
<tr>
<td></td>
<td><em>Example:</em> The square root of 81 is ____</td>
</tr>
<tr>
<td>Short Answer - Selection From List</td>
<td>A question with a single answer, selectable from a given list.</td>
</tr>
<tr>
<td></td>
<td><em>Example:</em> Which of these planets is the largest?</td>
</tr>
<tr>
<td></td>
<td><em>Choices:</em> Pluto, Jupiter, Mars.</td>
</tr>
<tr>
<td>Short Answer - Rating</td>
<td>A question that allows the respondent to choose a single answer on a given scale.</td>
</tr>
<tr>
<td></td>
<td><em>Example:</em> Rate your dining experience in New York City.</td>
</tr>
<tr>
<td></td>
<td><em>Choices:</em> 1, 2, 3, 4 or 5 stars.</td>
</tr>
<tr>
<td>Short Answer - Essay</td>
<td>A question that allows the respondent to provide an answer in one or two sentences or paragraphs.</td>
</tr>
<tr>
<td>Multiple Choice - Single Answer</td>
<td>A multiple choice question with only one answer.</td>
</tr>
<tr>
<td></td>
<td><em>Example:</em> 2+2 equals...</td>
</tr>
<tr>
<td></td>
<td><em>Choices:</em> 1, 2, 3, 4, or None of the Above</td>
</tr>
<tr>
<td>Multiple Choice - Multiple Answers</td>
<td>A multiple choice question with one or more answers.</td>
</tr>
<tr>
<td></td>
<td><em>Example:</em> Pick a number that is greater than 5.</td>
</tr>
<tr>
<td></td>
<td><em>Choices:</em> 6, 7, 8, 9, or All of the Above</td>
</tr>
</tbody>
</table>
6 Select the question type you want for your first slide, for example **Multiple Choice - Single Answer** and type the question or statement in the **Question** box at the bottom of the **Question** dialog box.

7 Click **OK**. The dialog box closes, and the quiz question type name appears in the **Quiz Questions** list box.

8 To create multiple quiz slides for your quiz project, repeat steps 5 and 6 for each new slide. You can use the same question type for each slide, or you can select a different question type for different slides.

9 Once you have created all the quiz slides you need, click **OK**. After a few moments, the **Create New Project** window closes, and the Quiz project window opens. The

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Multiple Choice - Fill in the Blanks** | A question containing more than one ‘fill in the blanks’.  
*Example*: Roses are _____ and Violets are _______. |
| **Multiple Choice - Selection from Lists** | A question where respondents select answers from a list of choices.  
*Example*: What is the capital of each of these countries?  
Japan - **Choices**: Tokyo, Osaka, Kyoto  
U.S.A. - **Choices**: New York City, Washington D.C., San Francisco |
| **Multiple Choice - Rating** | A question where respondents rate several items.  
*Example*: Rate the weather in these countries.  
Canada - **Choices**: 1, 2, 3, 4, or 5 stars  
Italy - **Choices**: 1, 2, 3, 4, or 5 stars |
| **Multiple Choice - True/False** | Respondents specify whether a statement is true or false.  
*Example*: Mars is the planet closest to the sun.  
**Choices**: True, False |
| **Likert Scale** | A statement where respondents specify their level of agreement with a statement.  
*Example*: The customer service representative was very helpful.  
**Choices**: Strongly Disagree, Disagree, Somewhat Disagree, Agree, Strongly Agree |
main (right) panel shows the first quiz slide in the project, while the left panel shows, if selected, the Thumbnails or Stylesheets panel.

You are now ready to work with your quiz slides’ window view (for example, closing the Thumbnails panel, and opening the Stylesheets panel). You can edit the questions in the slides, set scoring options, edit their appearance, add annotations, special effects, insert other slides (such as quiz slides), and more.

See:
- Navigating in a Project Window on page 51.
- Working With Project Views on page 55, for details on working with such views as Thumbnails and Stylesheets views.
- Chapter 4, Adding Illustrative Objects to Slides, page 66 and Chapter 5, Adding Dynamic Elements to Slides, page 85, for details on adding annotations or editing the appearance of your quiz slides.
- Chapter 6, Setting Scoring Options for Interactive Zones, page 134.
- Chapter 9, Publishing Clip Projects, page 164, for details on publishing your quiz project clip.
Creating Image Projects

With Content Producer, you can create an image slide project, that is made up of slides containing images that you import to Content Producer Author from your hard drive or disk.

You can compile and publish an image slide project as a clip, or you can insert selected image slides into another project, such as a screenshot project.

See:
- Creating an Image Project, page 44

Creating an Image Project

1. Launch Content Producer Author. For details, see Chapter 2, Launching Content Producer Author, page 20.

2. In the Content Producer Author window, click New Project. The Create New Project window opens.

3. In the left panel of the window, select Image Project. The right panel of the window refreshes to show image project options.
4 From the Slide Size list box, select one of the two size options described in the table below:

<table>
<thead>
<tr>
<th>Slide Size</th>
<th>Actions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Specify a custom width and height</td>
</tr>
<tr>
<td></td>
<td>If you select this option, the window refreshes with a Width box and a Height box below the Slide Size drop-down list:</td>
</tr>
<tr>
<td></td>
<td>Select or type the width and height you want for the slides in your image slide project.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Width and Height Boxes" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Tip" /> If you are inserting image slides from this project into, for example, a screenshot project, make sure that you select the same dimensions for the image slides as you did for the screenshot slides.</td>
</tr>
<tr>
<td>Standard</td>
<td>Select a standard window size</td>
</tr>
<tr>
<td></td>
<td>If you select this option, the window refreshes to with a drop-down list box below the Slide Size drop-down list, as well as tools to modify standard sizes:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Standard Sizes" /></td>
</tr>
<tr>
<td></td>
<td>a. Click the arrow beside the box, and select a window size for the image slide, such as SVGA (Recommended) 800 x 600.</td>
</tr>
<tr>
<td></td>
<td>b. If you want to add a size to the list, click the green cross button, type a name for the new size, and then select or type the width and height dimensions.</td>
</tr>
<tr>
<td></td>
<td>c. To modify an existing size in the list, select the size, and then click the pencil icon. In the Standard Resolution dialog box, change the name and/or dimensions as required.</td>
</tr>
<tr>
<td></td>
<td>d. To delete an existing size, select the size, click the delete icon, and then click Yes at the message prompt.</td>
</tr>
</tbody>
</table>

5 In the Select Images area, click the green cross button beside the list box. The Select Image Files window opens. Navigate to and locate the image file or files that you want to select for a slide. Then click Open. The Select Image Files window closes, and the list of files appears in the list box.

![Tip](image) If you are selecting multiple consecutive image files, select the first file and then press SHIFT as you select the last file. If you are selecting non-consecutive multiple image files, press and hold CTRL as you select each file.
6. To scale an image to fit slide dimensions, select the **Stretch** check box for each image file listed in the list box.

   If you do not select **Stretch**, images not scaled to fit the slide’s dimensions are cropped (if larger than slide size) or centered (if smaller) on the slide.

7. To preview an image, select it. The image displays on the right side of the screen.

   ![Image Preview](image.png)

   The imported images are embedded as slide backgrounds.

8. To rotate an image left or right, from the list box, select the image, and then click the Rotate Left button or Rotate Right button.

9. Click **OK**. After a few moments, the **Create New Project** window closes, and the Image project window opens. The main (right) panel shows the first image slide in the project, while the left panel shows, if selected, the **Thumbnails** or **Stylesheets** panel.

   ![Image Project Window](image.png)

10. You are now ready to work with your image slides’ window view (for example, you can close the **Thumbnails** panel, and open the **Stylesheets** panel), edit the slides’
appearance, add annotations, special effects, insert other slides into the project, publish the project, and more.

See:

- [Navigating in a Project Window](#) on page 51
- [Working With Project Views](#) on page 55, for details on working with such views as Thumbnails and Stylesheets views.
- [Chapter 4, Adding Illustrative Objects to Slides, page 66](#) and [Chapter 5, Adding Dynamic Elements to Slides, page 85](#), for details on adding annotations or editing the appearance of your slides
- [Chapter 9, Publishing Clip Projects, page 164](#), for details on publishing your quiz project clip.
Creating Blank Projects

When creating a new project, you can quickly create a single blank slide without screenshots or images by choosing the **Blank Project** option when you launch Content Producer.

You can then edit blank slides by importing and embedding background images onto them, and/or adding interactive zones and other objects such as notes and balloons.

Creating a Blank Project

1. Launch Content Producer Author. For details, see [Chapter 2, Launching Content Producer Author, page 20](#).
2. In the Content Producer Author window, click **New Project**. The **Create New Project** window opens.
3. In the left panel of the window, select **Blank Project**. The right panel of the window refreshes to show blank project options.
4 In the **Slide Size** area, select one of the two size options described in the table below:

<table>
<thead>
<tr>
<th>Slide Size</th>
<th>Actions Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom</td>
<td>Specify a custom width and height</td>
</tr>
<tr>
<td></td>
<td>If you select this option, the window refreshes with a <strong>Width</strong> box and a <strong>Height</strong> box below the <strong>Slide Size</strong> drop-down list:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>Select or type the width and height you want for the slides in your image slide project.</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>If you are inserting image slides from this project into, for example, a screenshot project, make sure that you select the same dimensions for the image slides as you did for the screenshot slides.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard</th>
<th>Select a standard window size</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If you select this option, the window refreshes to with a drop-down list box below the <strong>Slide Size</strong> drop-down list, as well as tools to modify standard sizes:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Image" /></td>
</tr>
<tr>
<td></td>
<td>a. Click the arrow (\downarrow) beside the box, and select a window size for the image slide, such as <strong>SVGA (Recommended) 800 x 600</strong>.</td>
</tr>
<tr>
<td></td>
<td>b. If you want to add a size to the list, click the green cross button (\times), type a name for the new size, and then select or type the width and height dimensions.</td>
</tr>
<tr>
<td></td>
<td>c. To modify an existing size in the list, select the size, and then click the pencil icon (\text{edit}). In the <strong>Standard Resolution</strong> dialog box, change the name and/or dimensions as required.</td>
</tr>
<tr>
<td></td>
<td>d. To delete an existing size, select the size, click the delete icon (\times), and then click <strong>Yes</strong> at the message prompt.</td>
</tr>
</tbody>
</table>

5 In the **Slide Count** area, in the **Enter the number of slides you want to create** box, type or select the number of blank slides you want to create for the project.

6 Click **OK**. After a few moments, the **Create New Project** window closes, and the Blank project window opens. The main (right) panel shows the first blank slide in the project, while the left panel shows, if selected, the **Thumbnails** or **Stylesheets** panel.

You are now ready to work with your blank slides’ window view (for example, you can close the **Thumbnails** panel, and open the **Stylesheets** panel), edit the slides’
appearance, add annotations, special effects, insert other slides into the project, publish the project, and more.

See:

- [Navigating in a Project Window](#) on page 51
- [Working With Project Views](#) on page 55, for details on working with such views as Thumbnails and Stylesheets views.
- [Chapter 4, Adding Illustrative Objects to Slides, page 66](#) and [Chapter 5, Adding Dynamic Elements to Slides, page 85](#), for details on adding annotations or editing the appearance of your slides
- [Chapter 9, Publishing Clip Projects, page 164](#), for details on publishing your quiz project clip.
Working in a Project Window

Once you have opened or created a clip project, the project window opens, within which you can perform a variety of tasks:

- [Navigating in a Project Window](#) on page 51
- [Working With Project Views](#) on page 55
- [Viewing and Working with a Thumbnails View Only](#) on page 57
- [Viewing and Working in Stylesheets View Only](#) on page 60

Navigating in a Project Window

Each project window contains the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Menu bar</td>
</tr>
<tr>
<td>2</td>
<td>Project toolbar</td>
</tr>
<tr>
<td>3</td>
<td>Thumbnails, stylesheets, or browser panel. Can also be changed to window view.</td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

- See [The Menu Bar](#) on page 52.
- See [The Project Toolbar](#) on page 53
- See [Working With Project Views](#) on page 55
The Menu Bar

The menu bar contains the following menus:

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
</table>
| File   | Click this menu if you want to:  
  - Create a new project  
  - Open an existing project  
  - Open a recent file  
  - Save the project  
  - Set the project’s print layout  
  - Export slides  
  - Import slides |
| Edit   | Click this menu if you want to:  
  - Cut, copy, or paste a slide or content within a slide  
  - Delete or duplicate a slide  
  - Set slide preferences  
  - Arrange, align, distribute, size, or set timing for various components you add to a slide |
| View   | Click this menu if you want to view:  
  - Tooltips, cursor path, spelling mistakes, event icons, attached sound icons, and/or the status bar  
  - browser, thumbnails, stylesheets, timeline, or slide notes panels |
| Insert | Click this menu if you want to insert:  
  - new screenshot, quiz, image, or blank slides between existing slides in your project  
  - various components onto a selected slide, such as balloon notes, text, images, movies, or interactive zones such as click zones, pause zones, text zones, and more. |
The Project Toolbar

The project toolbar buttons allow you to make changes to your project or individual slides with a click of the mouse.

Use each button as follows:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Begin new project</td>
</tr>
<tr>
<td>2</td>
<td>Open existing project</td>
</tr>
<tr>
<td>3</td>
<td>Save project</td>
</tr>
<tr>
<td>4</td>
<td>Print project</td>
</tr>
<tr>
<td>5</td>
<td>Cut slide</td>
</tr>
<tr>
<td>6</td>
<td>Paste slide</td>
</tr>
<tr>
<td>7</td>
<td>Undo action</td>
</tr>
<tr>
<td>8</td>
<td>Delete slide</td>
</tr>
<tr>
<td>9</td>
<td>Insert a blank slide after a selected slide</td>
</tr>
<tr>
<td>10</td>
<td>Create new screenshots. After you click this button, follow the procedure described under Creating Screenshot Projects on page 27. New screenshots are inserted after the selected slide.</td>
</tr>
</tbody>
</table>
### Button | Function
--- | ---
11 | Create slides with embedded images. After clicking this button, follow the procedure described under Creating Image Projects on page 44. New slides are inserted after the selected slide.
12 | Format painter - use this feature to change text properties in balloons, notes and text boxes. You can also use the Format Painter to apply properties of one shape object to another throughout your project.
13 | Begin spell check.
14 | Open Stylesheets panel (see below, Viewing and Working in Stylesheets View Only, page 60).
15 | Begin search and replace process.
16 | Go to the first slide in the project.
17 | Go to the previous slide.
18 | Go to the next slide.
19 | Go to the last slide.
20 | Preview current slide, or other slides. You can also select an option to preview entire project in a web browser, as it appears once it is published. See Chapter 9, Publishing Clip Projects.
21 | Set project properties. See details about compiling and publishing your clip project in Chapter 9, Publishing Clip Projects.
22 | Launch the clip publication process. See details about compiling and publishing your clip project in Chapter 9, Publishing Clip Projects.
23 | View selected slide properties.
24 | Make a hidden slide visible again in a clip project.
25 | Hide a selected slide in a clip project. If you click this button, the selected slide is greyed out.
26 | Duplicate a selected slide. The duplicate appears next the selected slide.
27 | Insert a background color on one or more slides. For details, see Embedding a background color or image on one or more slides on page 59.
28 | Insert an embedded image to one or more slides. For details, see Embedding a background color or image on one or more slides on page 59.
29 | Attach a sound to a selected slide. For details on attaching audio, see Attaching Audio to Slides or Slide Objects on page 96.
30 | Add ‘slide events’ to a slide. Events are triggered by a user action in a slide. For details, see Attaching Events to Slides and Slide Objects on page 88.
Working With Project Views

With Content Producer Author, you have a number of project view options:

- Opening the Thumbnails, Stylesheets, and/or Browser view on the Left Panel on page 55.
- Viewing a selected slide only on page 57
- Viewing and Working with a Thumbnails View Only on page 57
- Viewing and Working in Stylesheets View Only on page 60

Opening the Thumbnails, Stylesheets, and/or Browser view on the Left Panel

You can open new views in the left panel, or switch the view in the left panel if more than one view is open.

See:

- To open a new view in the left panel on page 55
- To switch views in the left panel if more than one view is open: on page 57

To open a new view in the left panel

1. On the menu bar in the Content Producer Author project window, click View.
2. Select one of these view options:
   - **Browser** (to see the file structure on your local hard drive)
   - **Thumbnails** (to see small images of all slides in your project)
   - **Stylesheets** (to change slide properties, as well as the properties of the elements you add to your slides, such as buttons, clickable areas, questions, and so on)

The view you select opens in the left panel.
3. If you want to open several views at once, repeat steps 1-2. The left panel refreshes with the most recent view you opened. For example, if the last view you opened was the **Stylesheets** view, the Stylesheets view opens in the left panel.

At the top of the left panel you can also see the abbreviated names of the other views, if you had selected those earlier:
To switch views in the left panel if more than one view is open:

Click the abbreviated name of the view to which you would like to switch. For example, if you have the Stylesheets view open, click **Thumbnails** to open the Thumbnails view in the left panel.

Viewing a selected slide only

1. In Thumbnails view, select a slide.
2. On the Menu Bar, click **View**, and deselect all view options. The screen refreshes; the left panel is no longer visible, and the selected slide remains in the project window.

For details about working in a selected slide, see Chapter 4, Adding Illustrative Objects to Slides, page 66 and Chapter 5, Adding Dynamic Elements to Slides, page 85.

3. To re-open the left panel with a Thumbnails, Stylesheets, and/or Browser view, click **View** again, and select the view you want to open.

Viewing and Working with a Thumbnails View Only

You can set the window view so that only the Thumbnails view is open, showing small images of all the slides in your clip project.

Working in the Thumbnails view is useful when you want to:

- Move slides from one spot in the project to another
- Hide/show slides
- Add or import new screenshot, quiz, image, and/or blank slides
- Embed a new image or background on one or more selected slides
- Duplicate one or more selected slides

See:
- Opening the Thumbnail view only on page 58
- Moving slides in Thumbnail View on page 58
- Embedding a background color or image on one or more slides on page 59
- Hiding/showing slides in Thumbnail View on page 59
- Duplicating Slides in Thumbnail View on page 59

Opening the Thumbnail view only

1. Make sure that the Thumbnail view is open in the left panel (see To open a new view in the left panel on page 55).
2. At the top right corner of the left panel, click the expand view button. The Thumbnail view opens.

3. To return to the previous view, click the close full view button located at the upper right corner of the panel. The screen refreshes, with the Thumbnails view in the left panel, and the selected slide in the right panel.

Moving slides in Thumbnail View

1. Select one or more slides that you want to move.
2 Click and drag the slide(s) to the new location and release to drop them into place. When you complete this task, slide numbers are automatically numbered.

Embedding a background color or image on one or more slides

1 Select one or more slides for which you want to change the background color or image.

If you are selecting consecutive slides, select the first slide in a series, then press SHIFT on your keyboard and click the last slide in the series. If you are selecting multiple non-consecutive slides, press and hold CTRL on your keyboard as you select each slide.

2 Do one of the following:
   - If you are embedding a background image onto one or more slides, on the Project Toolbar, click the Background Image button . In the Background Image window, navigate to and locate the image you want as the slide background, and select it. Click OK
   - If you are embedding a background colour onto one or more slides, on the Project Toolbar, click the Background Color button . In the Background Color dialog box, select a color from the color palette, or create your own custom color by specifying values from 0 to 255 in RGB color mode. The color you create will also appear in one of the Recent palette boxes. Click OK when done.

The new background image or color appears on each selected slide.

Hiding/showing slides in Thumbnail View

1 To hide a slide, click the Hide button . The slide displays as a grey shadow, and an “X” displays in the lower left corner, indicating the slide is hidden.

2 To show a hidden slide, click the Show button .

Hidden slides do not play back in Content Producer while you preview the project in Slide View Play Mode, nor will they appear in the final Clip.

Duplicating Slides in Thumbnail View

1 Select one or more slides that you want to duplicate.

2 Click the Duplicate Slide button . The duplicated slide or slides appear to the right of the selected slide.
Viewing and Working in Stylesheets View Only

You can set the window view so that only the Stylesheets view is open. You use Stylesheets to set the properties that you want to apply to all slides, and all slide objects (such as buttons, messages, text boxes, balloons, and so on).

Opening the Stylesheets view only

1. Make sure that the Stylesheets view is open in the left panel (see To open a new view in the left panel on page 55).
2. At the top right corner of the left panel, click the expand view button . The Stylesheets view opens.

3. The screen refreshes, showing the list of all stylesheets that are currently available.
4. To return to the previous view, click the close full view button located at the upper right corner of the panel. The screen refreshes, with the Stylesheets view in the left panel, and the selected slide in the right panel.
Modifying Existing Stylesheets

1. To modify a stylesheet, select the stylesheet you are interested in changing, for example the **Balloon** stylesheet (balloons are objects that you insert into slides to describe a specific area of the slide). The heading expands to show the elements that can be modified using the selected stylesheet.

   ![Balloon Stylesheet Example](image)

   For example, with the **Balloon** stylesheet, you can change the message style, background color, and text properties.

2. To modify a stylesheet, click one of the stylesheet elements, for example, **Text Properties**. Depending on the object for which you are modifying the stylesheet, and its element, a dialog box opens with a list of options, such as the **Text Properties** dialog box.

   ![Text Properties Dialog](image)

3. Select the option which you want to apply, and then click **OK** to close the dialog box.

4. To apply the changes to the entire project immediately, right-click the name of the stylesheet element you modified in Step 2, such as **Text Properties**, and choose **Apply Stylesheet to Project**. All slides in the clip refresh to show the modifications you made.

5. For more details on applying style elements to individual objects, see **Chapter 4, Adding Illustrative Objects to Slides, page 66**.
Inserting or Importing Slides to your Clip Project

You can add screenshot, quiz, image, or blank slides to your clip project. You can also import slides from other projects to insert in your current project. This is easiest to do in Thumbnail view (for details, go to Viewing and Working with a Thumbnails View Only on page 57).

See:
- Inserting a screenshot slide on page 62
- Inserting a quiz slide on page 62
- Inserting an image slide on page 63
- Inserting a blank slide on page 63
- Importing Slides from other clip projects on page 64

Inserting a screenshot slide

1. Select the slide beside which you want to insert new screenshot slides.
2. On the Project Toolbar, click the Insert New Screenshots button . The Insert Screenshots dialog box opens.
3. Follow the instructions in the procedure Creating Screenshot Projects on page 27 to create one or more screenshot slides.
   - Make sure that the slides you create are the same size as the existing slides in your project.
4. When you finish capturing the new screenshots, the new screenshot slides are inserted to the right of the selected slide.

Inserting a quiz slide

1. Select the slide beside which you want to insert new screenshot slides.
2. On the Menu Bar, click Insert > Question Slides. The Add Questions dialog box opens.
3. Add question slides as described from Step 5 to Step 9 in the procedure Creating a Quiz Project on page 39.
4. When you finish creating the new quiz slides, they are inserted to the right of the selected slide.
Inserting an image slide

1. Select the slide beside which you want to insert image slides.
2. On the Project Toolbar, click the Insert Image Slides button. The Select Images to Import dialog box displays.
3. Select images to import as described from Step 5 to Step 9 in the procedure Creating an Image Project on page 44.
4. When you finish creating the new image slides, they are inserted to the right of the selected slide.

Inserting a blank slide

1. Select the slide beside which you want to insert a blank slide.
2. On the Project Toolbar, click the Insert Blank Slide button. A blank slide appears beside the slide you selected.
3. Repeat to insert additional blank slides.
Importing Slides from other clip projects

Content Producer allows you to import slides from other clip projects that contain slides

⚠️ If the slides in your current project were created for viewing on handheld devices (dimensions 320x320), you cannot import slides meant for viewing on laptops or desktops (dimensions 640x480).

⚠️ To avoid file corruption, do not copy or paste slides between your Clip projects.

1. In Thumbnail view, select the slide beside which you want the imported slides to appear.
2. On the Menu Bar, click File > Import > Import Slides. The Import slides window opens.

3. Click Browse to open the Open File window.
4. Locate and select the clip project whose slides you want to insert in your current project (clip projects are always shown with the *.qvp file format).
5. Click Open. The Import Slides dialog box refreshes to show all the project slides in the clip you selected.

6. Select the slide or slides you want to import into your current clip project, and click OK.
If you are selecting multiple consecutive slides, select the first slide in a series, then press SHIFT on your keyboard and click the last slide in the series. If you are selecting multiple non-consecutive slides, press and hold CTRL on your keyboard as you select each slide.

7 Click OK. The imported slides are inserted to the right of the selected slide.
This chapter describes how you can add a variety of illustrative objects to individual slides, such as text objects (such as balloons and notes) and shapes (such as rectangles and circles), as well as images.

The chapter contains these sections:
- About Objects on Slides, page 67
- Tools Palette Overview, page 68
- Using note, balloon and text tools, page 69
- Adding text to balloons, notes and text frames, page 74
- Using the Spell Checker, page 78
- Exporting/Importing Text for Translation, page 79
- Adding Shapes to slides, page 80
- Inserting and editing images on slides, page 84
About Objects on Slides

Using the Tools palette, you can add objects to individual slides such as text balloons, notes, shapes, and images to illustrate learning topics and to enhance the slide.

For details about interactive objects you can add to a slide, see Chapter 5, Adding Dynamic Elements to Slides on page 85.

With the context-sensitive toolbars that appear at the top of your screen, and are associated with each type of object, you can then modify each object you add to the slide.

Alternatively, you can use the Stylesheets feature to set the attributes for slide objects, such that these attributes are applied to the slide objects on each slide of your clip project. This is very useful if you decide to change the text attributes, colors, or orientation across an entire project. For details on Stylesheets, see Viewing and Working in Stylesheets View Only on page 60 in Chapter 3, Creating and Navigating in Clip Projects.
Tools Palette Overview

The Tools palette is always located at the right edge of your screen. The table below describes the object that is associated with each tool button on the palette.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Balloon tool. Several balloon shapes are available. See Using note, balloon and text tools on page 69.</td>
</tr>
<tr>
<td>2</td>
<td>Note tool. Several note shapes are available. See Using note, balloon and text tools on page 69.</td>
</tr>
<tr>
<td>3</td>
<td>Text Frame tool. See Using note, balloon and text tools on page 69.</td>
</tr>
<tr>
<td>4</td>
<td>Cursor tool. Use to show or hide the cursor movement for a slide. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>5</td>
<td>Shape tool. Several shape options are available. Adding Shapes to slides on page 80.</td>
</tr>
<tr>
<td>6</td>
<td>Image tool. See Inserting or Importing Slides to your Clip Project on page 62.</td>
</tr>
<tr>
<td>7</td>
<td>Button tool for interactive button. Several button options are available, or you can create your own button. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>8</td>
<td>Movie tool. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>9</td>
<td>PauzeZone tool. Creates interactive zone on the slide for pausing the clip. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>10</td>
<td>ClickZone tool. Creates interactive click zone on your slide. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>11</td>
<td>TextZone tool. Creates interactive text zone on your slide. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>12</td>
<td>KeystrokeZone tool. Creates interactive keystroke zone on your slide. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
<tr>
<td>13</td>
<td>Question tool. Use to insert an interactive quiz-type question. See Chapter 5, Adding Dynamic Elements to Slides.</td>
</tr>
</tbody>
</table>
Using note, balloon and text tools

To enhance your slides, you can insert or modify balloons, notes and text frames. Procedures for working with these objects are similar.
See:
When to use a note, balloon or text frame on page 69
Inserting/deleting a note, balloon or text frame on page 70
Moving a note, balloon or slide text frame on page 70
Changing a note or balloon’s background color on page 70
Changing a balloon, note or text frame shape on page 72
Re-sizing a slide note, balloon or text frame on page 73
Adding text to balloons, notes and text frames on page 74

When to use a note, balloon or text frame

Notes
You can use notes to summarize information on your slide:

Balloons
You can use balloons to draw attention to specific areas on your slide:

Slide Text
You can use text frames to annotate various areas on your slide:
To be able to give a text frame a color fill, you must add a shape to your slide, give it a color fill, and then superimpose a text frame over it. For details on shapes, see Adding Shapes to slides on page 80.

Inserting/deleting a note, balloon or text frame

To insert a note, balloon or text frame on your slide

1. Click either the Note, the Balloon or the Slide Text tool button.
2. Move your cursor over the slide, until the cursor changes to a cross-hair shape.
3. Position this cursor at the spot where you want to insert the note, balloon, or text frame, and click to insert the item. The shape you selected displays on your slide.

   You can add as many notes and balloons on your slide as you want.

To delete a note, balloon or text frames

To delete a balloon, note, or text frame on your slide, select it, and then select Delete from the Edit menu or press DELETE on your keyboard. The object is deleted from the slide.

Moving a note, balloon or slide text frame

1. Click once inside the note, balloon or text frame. The pointer changes to a hand shape.
2. Click and drag the object to its new position on the slide, and release.

Changing a note or balloon’s background color

You can change a note or balloon’s background color either for a single slide, or across the entire project.

See:
- Changing the background color for a single object on page 70
- Applying a new background color for all slides using Stylesheets on page 71

Changing the background color for a single object

1. Click once inside the note or balloon for which you want to change the background color.
2 Right-click and select **Background Color** from the menu, or click the Background Color button on the toolbar to display the color palette, which is similar to the graphic shown below:

![Background Color Palette](image.png)

3 From the color palette, select the color that you want as the balloon or note’s background color.

![RGB and Hexadecimal Codes](image.png)

While you can set a color by clicking a color swatch, you can also select the RGB settings for a color or type its hexadecimal code in the text box. In the graphic example above, the RGB value is 255, 255, 255, the hexadecimal code is #FFFFFF, and the color is white.

4 Click **Apply** and then **OK** to apply the color to your object, and to close the dialog box.

**Applying a new background color for all slides using Stylesheets**

Using Stylesheets, you can change the background color for a selected object so that the next time a user inserts that object on any slide in the project, the new background color appears.

To apply a new background color for all slides

1 Make sure that the Stylesheets view is open in the left panel of your screen. For details on working with Stylesheets, see Viewing and Working in Stylesheets View Only on page 60, in Chapter 3, Creating and Navigating in Clip Projects.

2 Select the object - such as the balloon - on your slide. In the left panel, in the Stylesheets view, the **Balloon** stylesheet expands to show a list of style elements.

3 Click the Background Color button in the **Balloon** stylesheet, and follow steps 3 & 4 in the procedure Changing the background color for a single object on page 70.

4 Right-click the stylesheet for the object (such as the balloon), and click **Apply Stylesheet to Project**.
Changing a balloon, note or text frame shape

You can change balloon, note, or text frame shapes for either individual shapes, or across your clip project.

See:
- Changing the shape of a balloon, note, or text frame for a single slide on page 72
- Applying a new balloon, note, or text frame shape for all slides using Stylesheets on page 72

Changing the shape of a balloon, note, or text frame for a single slide

1. On your slide, select the balloon, note, or text frame.
2. Right-click the object, and select Message Type on the menu or, on the object’s toolbar, click the Message Type button. A list of available shapes displays.

![Message Type dialog box]

3. Click beside the Select the message style drop-down list box, and select a message style to pick the overall shape that you want the balloon to have. If you are changing message styles for balloons, the default is Standard Message Style, but alternatively, you can select a Bubbles Message Style, Curvy Message Style, and more.

4. Click Apply and then OK to close the dialog box. The new shape is applied to your balloon, note, or text frame.

Applying a new balloon, note, or text frame shape for all slides using Stylesheets

Using Stylesheets, you can change the shape for a selected object so that the next time a user inserts that object on any slide in the project, the new shape appears.

To apply a new balloon, note, or text frame shape for all slides

1. Make sure that the Stylesheets view is open in the left panel of your screen. For details on working with Stylesheets, see Viewing and Working in Stylesheets View Only on page 60, in Chapter 3, Creating and Navigating in Clip Projects.
2 Select the object - such as the balloon - on your slide. In the left panel, in the Stylesheets view, the object's stylesheet expands to show a list of style elements.

3 Click the Message Type button in the Stylesheet panel. The Message Style dialog opens.

![Message Style dialog](image)

4 Click the arrow beside the Select the Message Style box, and select the message style you want to use.

5 Right-click the stylesheet for the object (such as the balloon), and click **Apply Stylesheet to Project**.

### Re-sizing a slide note, balloon or text frame

1 Click once on the object that you want to resize (such as a text frame) to display the resize handles:

```
\[ Annotate your slice \]
```

2 Position the pointer on one of the handles, and click and drag it to resize the note, balloon, or text frame.

3 Release to set the new size.
Adding text to balloons, notes and text frames

You can add text to balloons, notes, and text frames, and then use the Text toolbar to modify text appearance.

Adding text to a balloon, note, or text frame

1. Double-click inside the balloon, note or text frame to which you want to add text. You are now in Text Edit mode.

2. When the text cursor flashes, begin typing your text. The balloon, note or text frame automatically adjusts its size to accommodate the text.

   To line up text inside balloons, notes and text frames, use the Tab function as you would in a text document.

3. Use the Text toolbar to italicize, bold and/or underline your text. You can also change your font, point size, color, and alignment while in Text Edit mode. See Using the Text toolbar on page 74 for details.

4. To leave Text Edit mode, click outside the balloon, note or slide text frame.

Using the Text toolbar

When you add or edit text inside a balloon, note or text frame, the Text toolbar appears on the Project toolbar.

Use the Text toolbar to italicize, bold, or underline your text. You can also use it to change font type, size, color, and alignment.

Font type, text color and size tools

Italics, Underline and Bold buttons

Alignment buttons

See:
- Activating the text toolbar on page 75
- Italicizing, bolding or underlining text on page 75
- Changing font type and size on page 75
- Changing text color on page 75
- Changing text alignment on page 76
- Using the Stylesheet to Apply Changes to Text Properties for an Object on page 76
Activating the text toolbar

Double-click a balloon, note, or slide text object to enter Text Edit mode. A cursor blinks inside the object, the text toolbar displays, and you are ready to start modifying the text.

Italicizing, bolding or underlining text.

1 Select the text you want to edit.
2 Click the Italics, Underline or Bold button on the Text toolbar to apply the font style you want for the selected text.
3 To exit Text Edit mode, click outside the object.

Changing font type and size

1 Select the text you want to edit.
2 To change the font, click the arrow inside the Font Type list box to show the font list:

   Arial Black
   Comic Sans MS
   Courier New
   Default
   Dialog
   DialogInput
   Geneva
   Monospace

3 Select a new font, such as Courier New.
4 To change the font size, click the arrow inside the Font Size box to show the font size list, as shown below:

   12
   10
   11
   12
   14
   16
   18
   24
   36

5 Select a font size from the list, or type a new font size in the box.

Changing text color

1 Select the text you want to edit.
2 Click the Text Color button on the Text toolbar to open the color palette:

![Color Palette](image)

3 Click a color swatch to apply it to the selected text. Alternatively, set RGB values or type a hexadecimal figure (like #000000) in the text box.

4 Click **Apply** and **OK**. The dialog box closes and your text color is changed.

**Changing text alignment**

When the text cursor flashes in the object, click one of the Alignment buttons on the Text toolbar (such as the Left align button ) to change the alignment to left, center, or right.

**Using the Stylesheet to Apply Changes to Text Properties for an Object**

You can use Content Producer’s Stylesheets feature to make changes to to an object’s text properties, so that text in that object, next time it is inserted in any slide in the project, reflects the changes you made.

You can make changes to text properties for objects such as balloons, notes, text frames, quiz questions, and more.

To apply new text properties to an object on all slides

1 Make sure that the Stylesheets view is open in the left panel of your screen. For details on working with Stylesheets, see Viewing and Working in Stylesheets View Only on page 60, in Chapter 3, Creating and Navigating in Clip Projects.

2 Select the object - such as a balloon - on your slide. In the left panel, in the Stylesheets view, the object’s stylesheet expands to show a list of style elements.
3 Click the Text Properties button in the object’s stylesheet element list. The Text Properties dialog box opens.

4 You can make the following changes:
   - To change text font and size, click inside the Font and Size boxes.
   - To make changes to text style, click one of the Style buttons to italicize, underline or bold the text.
   - To change alignment, click one of the Alignment buttons to change to a left, center or right alignment.
   - To change text color, click the Color button, and follow instructions in the procedure Changing text color on page 75.

5 Click Apply and OK when you are finished to close the dialog box. The next time you type text anywhere in your project, the text will display with the new text properties.
Using the Spell Checker

Use Content Producer’s spell checking feature to search for spelling errors in your text as follows:

1. Ensure that a selected slide is open on your screen, and that you have inserted balloons, notes, text frames or other objects such as quiz questions and answers, that contain text.

2. Click the Spellcheck button on the Text toolbar. Misspelled words are now shown underlined in red.

3. Do one of the following:
   - Re-type the misspelled word correctly.
   - or -
   - Select the misspelled word and right-click your mouse. A drop-down list appears that includes the following options:
     - **Replace** to show a list suggested words you can use to replace the misspelled word
     - **Replace All** to show a list of suggested words you can use to replace all of the same misspelled words
     - **Ignore All** to ignore all instances of a particular error
     - **Learn** to add the word to the Spellcheck database
       Select one of these options to fix the spelling error.

To disable the spellchecker, click the Spellcheck button again. Misspelled words are no longer highlighted.
Exporting/Importing Text for Translation

You can export text from balloons, notes, text frames, and any other clip project objects that contain text (such as quiz questions, and so on) to an XML file. That file can then be imported back into your project with the translated text, re-inserted in the correct objects in the appropriate slides.

1. Select **File > Export > Export Text for Translation**. Click **Yes** at the message prompt to save your project file.

2. The **Export Text** window opens.

3. Type a name in the **File Name** box and then click **Save**. The file is saved in *.xml format.

4. Open the file with an XML-editing program, edit the file, and save it.

5. Re-open the project from which the text was exported. Select **File > Import Text for Translation** to import your changes. At the message prompt, click **OK**. The translated text replaces the existing text in your project.
Adding Shapes to slides

With Content Producer, you can use Shape tools to add shapes to individual slides that:
- provide background fill color for text frames annotating your slide.
- insert rectangles and ellipses shapes directly onto a slide.
- insert free-form (polygon) shapes directly onto a slide.

You can change a shape's fill color and opacity, as well as border color and thickness.

See:
- Adding and drawing Shapes on page 80
- Modifying shapes on page 81

Adding and drawing Shapes

To add a Shape

1. Ensure that a slide is open on your screen.
2. Select the Insert Shape button on the Tools palette; the context sensitive toolbar changes to include Add Shape icons:
   - Shape type buttons
   - Opacity options
   - Border thickness
   - Rollover button
   - Events button
   - Attach Sound button
   - Text Properties button
   - Background color button
   - Border color button

3. Click a shape type button on the toolbar to draw the following shapes.

To draw rectangles and ellipses

1. Click either the rectangle or the ellipse button on the toolbar (the default selection is the rectangle shape).
2. Click and drag your cursor on the slide to form the shape.
3. Release to insert the selected shape onto your slide. Examples of shapes are shown below:
To draw free-form shapes

1. From the toolbar, select the Lasso shape or the Poly Lasso shape button.
2. Click and drag your cursor on the slide to form the shape as follows:
   - If drawing a Lasso shape, click and drag your cursor on the slide to form any shape you want and release to insert the shape onto your slide.
     Here is an example of a Lasso shape (just before you release the mouse button):

     ![Lasso shape example](image)

   - If drawing a Poly Lasso shape, click the cursor on the slide to begin drawing the shape. Move the cursor to the next point and click again. Double-click to finish drawing the shape.
     Here is an example of a Poly Lasso shape (just before you release the mouse button):

     ![Poly Lasso shape example](image)

Modifying shapes

Moving a shape

1. Click inside the shape and drag it to a new location on the slide.
2. Release the mouse button.

Resizing shapes

1. Select the shape you want to resize.
2. Click and drag the resize handles to a new location on the slide and release the mouse button.
Modifying Shape Properties

1. Select the shape whose properties you want to modify.
2. Click the Shape Properties button. The **Shape Properties** dialog box opens.

3. Make changes to shape properties as required, then click **Apply** and **OK**.

Changing the fill color

1. Select a shape for which you want to change the fill color.
2. Click the Background Color button on the toolbar to display the color palette. (Note that the color in the Background Color button changes to matches the fill color of a selected shape).
3. Select a color swatch to apply. The color you select is shown in the large box on the lower right side of the color palette.
4. Click **Apply** and **OK** to save and close the color palette.
5. To globally change the color of the shape throughout your project, see [Applying a new background color for all slides using Stylesheets](#) on page 71.

Setting the fill color’s opacity

When you change the fill color’s opacity, you lighten or darken the shape’s fill color, making it more or less transparent.

1. Select a shape for which you want to set the opacity.
2. In the toolbar, use the up/down arrows in the Opacity options box and select a number to change shape color’s opacity percentage, or type a number in the box.

Changing border thickness

1. Select the shape for which you want to change the border.
2 On the toolbar, select or type a value in the Border Thickness options box. Thickness is measured in points.

Changing the border color
1 Select the shape for which you want to change the border color.
2 From the toolbar, click the Border Color button to display the color palette.
3 Select a new color for the shape’s border.
4 Click **Apply** and **OK** to save and close the color palette.

Deleting a shape
1 Select the shape you want to delete.
2 Right-click your mouse and select **Delete**, or press DELETE on your keyboard.

Adding events, rollover areas, and attaching sounds
You can attach interactive elements such as events, rollover areas and sounds to a number of objects that you insert on a slide.
For details about using the Events button ![Events Button], Create Rollover Area button ![Rollover Area Button], and the Attach Sound button ![Attach Sound Button], see **Chapter 5, Adding Dynamic Elements to Slides**.
Inserting and editing images on slides

You can insert images onto individual slides by using the Insert Image tool. Unlike embedded background images, you can resize, move and change the opacity of the images you insert.

For details on embedding background images, see Embedding a background color or image on one or more slides on page 59 in Chapter 3, Creating and Navigating in Clip Projects.

Inserting images onto slides

Open a slide in Slide View to import image files directly onto individual slides.

To import an image onto a slide

1. Click the Insert Image button on the Tools palette.
2. In the Insert an Image window, browse to and locate the image you want to place onto the slide, and select it. Click Open. The image displays on the slide.

Modifying inserted images

Resizing an image

1. Select the image you want to resize.
2. Click and drag the resize handles to a new location on the slide and release the mouse button.

Changing an image’s opacity

1. Select the image for which you want to change the opacity.
2. On the image toolbar at the above the slide, click the Opacity (%) button and select or type the opacity percentage you want to apply to the image.

   The higher the opacity percentage you select for the image, the more solid the image appears on the slide. For example, if you select 100%, the image appears solid. At 10%, it appears almost completely transparent.

Moving an image

Click inside the image you want to move and drag it to a new location. Release to drop the image into place.
Chapter 5

Adding Dynamic Elements to Slides

With Content Producer, you can add dynamic elements to slides, such as action triggers (called events), audio and movie clips, hyperlinks, mouse rollovers, and more.

This chapter contains the following sections:

- About Dynamic Elements in Slides, page 86
- Adding Events and Hyperlinks to Slides and Slide Objects, page 87
- Attaching Audio to Slides or Slide Objects, page 96
- Adding Movies to Slides, page 99
- Attaching Rollover Areas to Slide Objects, page 101
- Adding Buttons to Slides, page 103
- Working with the cursor, page 106
About Dynamic Elements in Slides

By adding such dynamic elements to selected slides as:

- actions and hyperlinks;
- audio;
- rollover areas;
- events triggered upon clicking an area of a slide, including rollover areas;
- movies; and
- buttons

Users can enter information, click areas or buttons, or roll over areas of a slide, and then trigger interactive results such as: jumping to other slides or to Web sites, loading recorded audio, loading movies, and more.

Features such as these enhance the learning features of your slides, and make the slides more interesting to users.

See:

- Adding Events and Hyperlinks to Slides and Slide Objects on page 87
- Attaching Audio to Slides or Slide Objects on page 96
- Adding Movies to Slides on page 99
- Attaching Rollover Areas to Slide Objects on page 101
- Adding Buttons to Slides on page 103
- Working with the cursor on page 106

Note that these dynamic elements can be attached to interactive zones that are inserted on your slides.

Interactive zones usually require that users perform an action or answer a question correctly for learning evaluation purposes. For details on interactive zones, see Chapter 6, Working With Interactive Zones.
Adding Events and Hyperlinks to Slides and Slide Objects

When you are using Content Producer Author, you can add events or hyperlinks to slides and objects.

Events

An event is an action triggered by users’ activities when viewing a slide. When an event is triggered by, for example, a user clicking a button or rolling over an area on the slide, an action or set of actions occurs - the clip progresses to the next slide, a new Web browser window opens, and so on.

Hyperlink

A hyperlink is visible on a slide as a selection of underlined text. When users click the underlined text, an action occurs - the clip progresses to the next slide, a new Web browser window opens, and so on. The same set of actions are available for both events and hyperlinks.

You add events and hyperlinks to slides and selected slide objects as follows:

- attach events directly to slides, shapes, interactives zones, images, and any rollover area. Depending on how you attach an event, events are triggered in one of these ways:
  - the clip presentation reaches the slide to which an event is attached.
  - the user clicks an interactive zone (such as a click zone, keystroke zone, pause zone, and so on) to which an event is attached.
  - the user clicks a control button in a Question zone (such as a radio button that belongs to a multiple choice question)
  - the user clicks an image to which an event is attached.
  - the user clicks a shape to which an event is attached.
  - the user clicks a rollover area to which an event is attached. Rollover areas are usually superimposed over other objects in a slide (for details about rollover areas, see Attaching Rollover Areas to Slide Objects on page 101).
- add hyperlinks to selected text in balloons, notes, text frames, and quiz questions and responses.

See:

- Adding Events and Hyperlinks to Slides and Slide Objects on page 87
- Adding Hyperlinks to Selected Text on page 94
Attaching Events to Slides and Slide Objects

You can attach one or more events to slides and slide objects, as well as modify or delete events, as required.

See:
- Attaching an Event to a Slide or Slide Object on page 88
- Modifying Event Actions Attached to Slides and Slide Objects on page 94
- Deleting Event Actions Attached to Slides and Slide Objects on page 94

Attaching an Event to a Slide or Slide Object

1. Open a slide, an interactive zone (such as a Click zone), and image, a shape (including a rollover area), or a button.
   For details on the above slide objects, see:
   - Opening a slide (see Viewing a selected slide only on page 57)
   - Selecting a shape (see Adding Shapes to slides on page 80).
   - Selecting an image (see Inserting and editing images on slides on page 84).
   - Selecting a rollover area (see Attaching Rollover Areas to Slide Objects on page 101).
   - Selecting an interactive zone (see About Interactive Zones on page 112).

2. Once you select the slide object to which you want to attach an event, click the Event button above the slide on the Toolbar. An Events dialog box opens.

Events dialog boxes

There are three types of Events dialog boxes. Dialog box tabs may vary slightly, depending on the object to which you are attaching the event:
Slide Events dialog box: if you selected a slide or interactive zone, this dialog box opens.

Using this dialog box, you attach events to such triggers as responding correctly, incorrectly, or incompletely when performing a required action on a slide. These triggers generally relate to tasks performed in an interactive zone. For details about interactive zones, see About Interactive Zones on page 112.

Events attached through this dialog box can also be triggered when the slide loads or ends, or when a user presses a particular key on a keyboard. For details about slides, see Viewing a selected slide only on page 57.
Shape Events dialog box: If you selected a shape or rollover area on a slide this dialog box opens.

With this dialog box, you configure events that are triggered once a user clicks or rolls over a particular area of a slide in the clip presentation. For details on shapes and rollover areas, see Adding Shapes to slides on page 80 and Attaching Rollover Areas to Slide Objects on page 101, respectively.

Button Events dialog box. If you select a button object on a slide, this dialog box opens.

With this dialog box, you configure events that are triggered when a user clicks the button. For details on button objects, see Adding Buttons to Slides on page 103.

3 On the selected tab, in the right panel, click the green plus sign +. The Actions dialog opens. All Events dialog boxes provide the same Action options in the Actions dialog box. No matter which tab you select, or which object you are applying an action to, the same action options are available.
4 Click the arrow beside the **Action Type: Select the action type from the list** box, and select an action from the list. Depending on the action you select, the dialog box refreshes, prompting you to complete additional steps. The table below lists actions and next steps.

### Event Action Type Table

<table>
<thead>
<tr>
<th>Action</th>
<th>Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Slide</td>
<td>From the drop-down list box, select the slide to which you want the user to jump.</td>
</tr>
<tr>
<td>Move to Slide</td>
<td>Select the number of slides by which you want the user to go forward or backward.</td>
</tr>
<tr>
<td>Repeat Slide</td>
<td>No further action required.</td>
</tr>
</tbody>
</table>
| Display URL    | Do the following:  
|                | 1 Select the URL to which you want the user to jump.                                                                                   |
|                | 2 Select a window destination, which is where you want the URL to open. This can be the same window, or another window (recommended). |
|                | 3 Specify the new browser window dimensions.                                                                                           |
|                | 4 Specify window options.                                                                                                              |
| Continue       | No further action required.                                                                                                              |
| Play Clip      | No further action required.                                                                                                              |
| Pause Clip     | No further action required.                                                                                                              |
| Email To       | Do the following:  
<p>|                | 1 Type the email address to whom you want to send the message.                                                                        |
|                | 2 Type a header in the subject line.                                                                                                   |
|                | 3 Type a message in the message area.                                                                                                  |</p>
<table>
<thead>
<tr>
<th>Action</th>
<th>Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Javascript</td>
<td>In the area provided, type the javascript for the action you want executed.</td>
</tr>
</tbody>
</table>
| Display Object     | Do the following:  
1. Click the arrow beside the **Select an object on the slide to display** box, and select the object. For example, if you are on the Incorrect Message tab in the Slide Events dialog box, you might need to select the Incorrect Message object option from the list.  
2. Click the arrow beside the **Duration** box, and select the appropriate duration for the object you selected. |
| Hide Object        | Click the arrow beside the **Select an object on the slide to hide** box, and select the object (for example, Incorrect Message, or Question Text).  |
| Insert Movie       | Do the following:  
1. Click beside the **Select a movie on the slide to play** box, and select a movie from your hard drive files or link to a URL.  
2. Click beside the **Duration** box, and select one of the movie duration options, for example Manual Timing or Fixed Duration. If you pick Manual Timing, specify the duration.  
For more details about selecting a movie to play, see Adding Movies to Slides on page 99. |
| Play Sound         | Do the following:  
1. Locate and select a sound from your files, or record the sound that you want to play when this action is triggered.  
2. If you want, check the **Wait for the sound to complete before advancing to the next action** box.  
For more details about adding audio, see Attaching Audio to Slides or Slide Objects on page 96. |
| Show Score         | No further action required.                                                                                                                  |
| Submit Question    | No further action required.  
Note: By default, this action is already selected for the Submit buttons that are part of a Question zone.  
See: Adding Question Zones on page 122. |
**Action** | **Next Steps**
--- | ---
Submit Score | No further action is required in the **Action** dialog box.

Note: Make sure this action is selected if you set scoring options for users’ successful actions when they use an interactive zone such as a Click zone, Text zone, Keystroke zone, or Question zone.

See:
- Details on interactive zones in [About Interactive Zones](#) on page 112
- Details on setting scoring options in [Setting Scoring Options for Interactive Zones](#) on page 134

Close Clip | No further action required.

---

5. Click **OK** when you have finished selecting and configuring your action. The action you selected appears in the list box on the tab you selected.

6. Repeat steps 3 to 5 to add additional actions to the event trigger. For example, the **On Correct** tab may contain a **Display Object** and a **Continue** action.

![Events dialog](image)

- If there are multiple actions, when triggered, they are executed consecutively, in the order in which they are listed on the tab.

7. Click **OK** to save and exit the **Events** dialog.
Modifying Event Actions Attached to Slides and Slide Objects

1. Select a slide or slide object to which an event is attached.
2. Above the slide on the Toolbar, click the Event button 🕒. The Events dialog box related to the selected slide or object opens.
3. From the Action list, select the action you want to modify, and click the pencil button 🖋️ on the right panel of the dialog box. The Action dialog box, containing the information you had configured for the action, opens.
4. Make changes to the action as required, then click OK twice to exit both dialog boxes. Your action has been updated.

Deleting Event Actions Attached to Slides and Slide Objects

1. Select a slide or slide object to which an event containing actions is attached.
2. Above the slide on the Toolbar, click the Event button 🕒. The Events dialog box related to the selected slide or object opens.
3. From the Action list, select the action you want to delete, and then click the delete button ✗ on the right panel of the dialog box. The action disappears from the list.
4. Click OK to close the dialog box.

Adding Hyperlinks to Selected Text

When you add a hyperlink to selected text, you have access to the same Action types available when you attach an event to a slide or a slide object (see Attaching Events to Slides and Slide Objects on page 88). Hyperlinks are then visible in your clip presentation as underlined, clickable text.

To add a hyperlink to selected text:

1. On the slide you are modifying, select the text that you want to use as a hyperlink. You can add a hyperlink to selected text in a:
   - balloon
   - note
   - text frame
   - quiz question/responses
2 Right-click the text and select **Hyperlink** or, on the object’s toolbar above the slide, click the Hyperlink button 🔄. The **Hyperlink** dialog box opens:

3 Click the **On Click** or **On Rollover** tab, and follow steps 3 to 6 in the procedure **Attaching Events to Slides and Slide Objects** on page 88.

4 Click **OK** to save the hyperlink and close the dialog box. The selected text is now underlined. When a user clicks the text or rolls over it, the action you selected commences.
Attaching Audio to Slides or Slide Objects

Content Producer supports a variety of WAV sound formats, including *.mp3 and *wav files.
You can select an audio file you want to attach to your slide, or you can record a new audio file to attach.
You can also replace or delete audio on your slide
Sound quality can range from low bandwidth up to CD quality, depending on the setting you configure for sound when compiling your clip (see Configuring Clip Project Properties on page 166), and on the user’s system.
See:
- Attaching Audio to a Slide or Slide Object on page 96
- Setting the Default Delay for Recording Sound on page 97
- Deleting Sound Attached to a Slide or Object on page 98

Attaching Audio to a Slide or Slide Object

1 Open the slide to which you want to attach the sound. You can attach the sound directly to the slide, or select a specific object on a slide to attach the sound to, such as a:
   - balloon
   - note
   - text frame
   - shape
   - click zone
   - text zone
   - keystroke zone
   - question zone
2 Right-click the slide or selected object on the slide and select the Attach Sound option or, on the toolbar above the slide, click the Attach Sound button 🎧. The Sound dialog box opens.

3 Do one of the following:
To attach an existing audio file, do the following:
1. Click the Load Sound button beside the Select or record a sound box.
2. In the Open window, locate and select the audio file you want to use (these can be in such file formats as *.mp3 or *.wav).
3. Click the Open button. The Open window closes, and the selected file name appears in the Select or record a sound box.

To record a sound, do the following.
1. Click the Record button and, if applicable, wait for the recording countdown to complete (for details about the countdown, see Setting the Default Delay for Recording Sound on page 97).
2. Record the sound.
3. When you are finished recording, click the Stop button. An *.mp3 file name appears in the Select or record a sound box. Once you save the clip project, this file is saved within the project.

Verify the sound you attached or recorded by clicking the Play button.

Click Apply and OK to attach the sound you loaded or recorded to the slide or selected slide object.

Setting the Default Delay for Recording Sound

Using Content Producer’s Preferences options, you can set the default delay (the ‘countdown’) before you commence recording a sound.

To set the default delay for recording sound
1. On the Menu Bar, click Edit > Preferences. The Preferences dialog box opens.

2. In the dialog box, click the General tab.
3. In the Recording area, check the Display Countdown Timer and then, in the Countdown Duration box, type or select the number of seconds for the delay.
4 Click **OK**. When you begin your next recording session, the timer countdown displays in the **Sound** dialog box once you press the Record button.

![Sound dialog box]

When the countdown number display ends, you can begin recording your sound.

**Deleting Sound Attached to a Slide or Object**

1. Open the slide or select the object to which you attached a sound.
2. Right-click the slide or selected object on the slide and select the **Attach Sound** option or, on the toolbar above the slide, click the Attach Sound button 🎧. The **Sound** dialog opens.
3. Click the Delete button 🗑 beside the **Select or record a sound** box. The file name inside the box disappears.
4. Click **OK** to save and exit the dialog box.
Adding Movies to Slides

You may want to add a movie clip to a slide as a training demonstration or for other illustrative purposes.
When you add a movie to a slide, users can click the movie icon, after which the movie loads and begins to play.
You can add a movie that has been stored as a video file on your hard drive, or you can add a URL that contains a movie clip.

Adding a Movie to a Slide

1. Select a slide in your presentation.
2. From the Tools palette at the right edge of your screen, click the Insert Movie button . The Insert Movie dialog opens.
3. You can either load a movie file located in your computer directory, or you can load a movie file from a URL:
   - To load a movie file from your computer directory, do the following:
     a. Click the Embed Movie File radio button, and then click the Load a Movie button beside the list box.
     b. In the Insert a Movie window, locate and select the movie file you want to load, and click Open. The dialog box refreshes to provide additional options.
   - To load a movie from a URL, do the following:
     a. Click the Load from URL radio button, and then click the button beside the box. The URL dialog box opens.
     b. In the URL dialog box, type the URL from which you want to load a movie, for example, a URL like http://www.phuongkhanhco.com/flashdata/butterfly.swf. The dialog box refreshes to provide additional options.

   The URL you use must specify an *.swf (flash) file.
4 If you want to display an animation while the movie loads, check the **Display waiting animation while the movie is being loaded** box.

You specify the pre-load animation file when you configure your clip properties. For details on configuring clip properties, see Chapter 9, Publishing Clip Projects.

5 If you want to customize timing options for your movie, click beside the list box in the **Timing** area, and select a timing option. Options include **Manual Timing** and **Until End of Slide**. Note that the **Fixed Duration** option is recommended to ensure that the movie clip plays in full. For the **Fixed Duration** option, in the **Start Time** box, specify how long you want to wait before starting the movie.

6 When you are finished configuring your movie options, click **OK**. A movie icon appears in the center of your slide.

![Movie Icon](image)

7 Do one or more of the following to modify the movie icon’s appearance:

- To resize the movie icon, select the icon and use the handles to resize it.
- To move a movie icon to another location on your slide, select the icon, then click and drag it to the new location.
- To arrange a movie icon so that is superimposed on another object, or behind another object, select the icon and right-click it. From the menu, select **Arrange**, and then select the appropriate option (for example, **Foreground** if you want to superimpose the icon on another object).

During a clip presentation, when users click the movie icon on the slide, a separate browser window opens and loads the movie.
Attaching Rollover Areas to Slide Objects

You can attach a rollover areas for certain objects on a slide if you want an event to be triggered when a user rolls a mouse over a particular slide object.

The slide objects to which you can attach a rollover area are:

- balloons
- notes
- text frames
- shapes
- images
- text frames that form part of quiz questions and other interactive zones.

Once you attach the rollover area to an object, you can select the event that you want triggered as a user rolls a mouse over that area.

Attaching a Rollover Area to a Slide Object

1. On an open slide, select an object to which you want to attach a rollover area.
2. On the toolbar above the slide, click the Create Rollover Area button or, right-click the selected object and choose Create Rollover Area. Then click the plus sign \+ that appears beside your selected object.

   A rollover area, with an Events icon \[\] at the top left corner, appears adjacent to the object.

3. Click the rollover area to select it and, using the handles, resize to cover the object it is attached to, as required.
4 Specify the event or events you want triggered when a user’s mouse rolls over the area.
For details on attaching an event to the rollover area, see Attaching Events to Slides and Slide Objects on page 88.
Adding Buttons to Slides

Insert buttons on slides if you want to allow clip viewers to advance through a clip presentation at their own rate.

Buttons are often inserted in conjunction with Pause zones, so that after a slide pauses, the user can click the button when ready to move on to the next slide. (For details on Pause zones, see Adding a Pause Zone on page 115)

You can also attach other actions to buttons, as required. You can configure buttons so that when clicked, the viewer skips ahead to different parts of your project instead of just progressing through it in a linear fashion. Actions attached to buttons can also allow viewers to open an email window, or load a movie or audio clip.

See:
- Inserting a Button on a Slide on page 103
- Selecting a Button Style on page 104
- Inserting Text on a Button on page 104
- Attaching an Action to a Button on page 105

Inserting a Button on a Slide

1. Open a slide and, on the Tools palette at the edge of your screen, click the Insert Button button. A default button appears on the slide.

2. To change the button style, see Selecting a Button Style on page 104.

3. To insert text on the button, see Inserting Text on a Button on page 104.

4. To attach an action to a button, such as advancing the presentation to the next slide, see Attaching an Action to a Button on page 105.
Selecting a Button Style

1. Right-click the button for which you want to change the style, and select **Button Style** from the menu. The **Button Style** dialog box opens.

2. In the dialog box, scroll down till you find the the button style you want to use, then select it.

3. Click **Apply** and **OK**. The dialog box closes, and the slide refreshes showing the button in the style that you selected.

Inserting Text on a Button

When you insert a button on a slide, you probably want to add instructions to the button so that viewers know they have to click it, and so that they understand what to expect when they click the button.

For example, if a slide pauses during the presentation because there is a Pause zone on the slide (see **Adding a Pause Zone** on page 115), you might want the button to contain text such as **Click to Continue** to let the viewer know that if they click the button after they are done viewing the slide, the presentation advances to the next slide.

To insert text on a button:
Select the button for which you want to insert text, right-click it and, from the menu list, select **Button Properties**.

The **Button Properties** dialog box opens.

1. In the **Name** area, type instructions for using the button in the **Text** box (for example, **Click to continue**).
2. Click **OK**. The dialog box closes and the button refreshes showing the new text.

### Attaching an Action to a Button

You must attach an action to any button you insert on a slide, so that when users click it, an action occurs, such as the presentation advancing to the next slide.

To attach an action to a button:

1. Right-click the button and, from the menu list, select **Events**; or click the **Events** button ⚡. The **Button Events** dialog box opens, on the **On Click** tab.
2. For descriptions of the types of actions you can attach to objects (including buttons), as well as instructions on how to attach actions to objects, see **Attaching Events to Slides and Slide Objects** on page 88.
Working with the cursor

You can show cursor movement on your learning clip, directing viewers’ attention to the action you are describing. Cursor movement can be modified to suit your requirements.

When watching a clip, viewers see a pointer (for example, mouse pointer) moving across a slide or series of slides.

See:
- Showing/hiding the cursor on page 106
- Modifying the cursor path on a slide on page 107
- Changing Cursor Appearance on page 109
- Adding a Click Sound to the Cursor on page 110

Showing/hiding the cursor

By default, the cursor and cursor path is always visible when you first open a slide in Slide View.

1. To show the cursor and its movement, on the Tools palette, click the Show Cursor button. The cursor displays on the slide.

- The green circle denotes the beginning position of the cursor’s movement.
The red circle shown in the graphic above denotes the end position of the cursor’s movement across the slide.

The cursor path progresses from slide to slide, so that the beginning position on a slide (denoted by the green circle) is shown as the end point (denoted by the red circle) on the next slide.

Both the green (beginning point) and red (end point) circles can be moved on a slide. The path changes accordingly on the next slide.

To hide the cursor, click the Hide Cursor button.

Modifying the cursor path on a slide

You can change the cursor path on a slide. This is useful if you are editing and re-combining screenshots, and want to show a new cursor path. See:

- Modifying the cursor path without changing where the path begins on page 107
- Modifying the cursor path and change where the path begins on page 107
- Moving the cursor path to the same place on the previous or the next slide on page 107
- Adding and Locking Points on a Cursor Path on page 108

Modifying the cursor path without changing where the path begins

1. Open the slide on which you want to modify the cursor path and, if the cursor path is not visible, click the Show Cursor button.
2. Click and drag the red circle (the end point of the cursor path) to its new location.

Modifying the cursor path and change where the path begins

1. Open the slide on which you want to modify the cursor path and, if the cursor path is not visible, click the Show Cursor button. The cursor path displays.
2. Move the green circle (the beginning point of the cursor path) to where you would like the cursor path to begin. Your cursor movement on that slide is now modified.

Moving the cursor path to the same place on the previous or the next slide

1. On the currently open slide, click the green or red circle on the cursor. The Cursor toolbar displays above the slide.
2. Do one of the following:
If you want the cursor position to be the same on the previous slide, click the Move cursor to the same place on the previous slide button.

If you want the cursor position to be the same on the next slide, click the Move cursor to the same place on the next slide button.

Adding and Locking Points on a Cursor Path

You can add a point to the path and then move the path into a different shape by dragging the point.

Once you have added and dragged a point on the path to where you want it, you can lock the point so that it cannot be moved again.

To add a point to a cursor path

1. Click the green circle (beginning point) of the cursor path. The Cursor toolbar appears above the slide.
2. On the toolbar, click the Add Point to Cursor Path button. A red point appears in the middle of the cursor path.
3. Click and drag the point to change the shape of the cursor path between the beginning and end points.
4. Repeat steps 2 and 3 if you want to add additional points. Each point will appear between the first point you added and the end point (the red circle) of the cursor path. You can click and drag these additional points to further alter the shape of the cursor path.

To lock a point on a cursor path

1. Click the point on the cursor path that you want to lock.
2. On the Cursor toolbar, click the Lock Point on Cursor Path button. The point is locked and cannot be dragged.
Changing Cursor Appearance

You can change a cursor’s shape and/or the type of cursor path movement (straight path, curved).

See:
- Changing a Cursor’s Shape on page 109
- Changing a Cursor’s Path Movement on page 109

Changing a Cursor’s Shape

1. Click the cursor arrow on the Tools palette to activate the cursor toolbar.
2. On the toolbar, click the Cursor style button . A selection of cursor shape options displays below the button.
3. Double-click the new shape you want the mouse cursor to display. The shape option box closes, and your mouse cursor displays on the slide with the new shape.

Changing a Cursor’s Path Movement

1. On the currently open slide, click the green or red circle on the cursor. The Cursor toolbar displays above the slide.
2. Do one of the following:
   - If you want the cursor path to be straight, click the Move the cursor in a straight path button .
   - If you want the cursor path to be curved, click the Move cursor in a curved path button .
Adding a Click Sound to the Cursor

1. On an open slide, click the green or red circle on the cursor. The Cursor toolbar displays above the slide.
2. On the toolbar, click the Add Click to Cursor Path button 🎵. When a slide plays, viewers hear a click sound when the cursor movement is shown on the slide.
Chapter 6

Working With Interactive Zones

With Content Producer, you can add interactive zones in which users can perform actions and answer questions as part of a learning and evaluation program.

This chapter contains the following sections:

- About Interactive Zones, page 112
- Inserting Interactive Zones on Slides, page 114
- Configuring Correct/Incomplete/Incorrect Messages, page 130
- Setting Scoring Options for Interactive Zones, page 134
- Modifying zones, page 136
About Interactive Zones

With Content Producer, you can add interactive components called zones to the slides in your clip.

Zones are tools that allow user interaction during a clip presentation, such as correctly completing actions and answering questions.

You can use interactive zones in your slides to evaluate user skills and knowledge as the users progress through your clip presentation.

See:
- Interactive Zone Types on page 112
- Tools Palette Overview on page 68
- Attaching Features to Zones on page 113

Interactive Zone Types

These are the interactive zone types you can add:

- **Pause Zone**
  With this type of zone on a slide, the clip presentation pauses when it reaches that slide, until the user clicks either the Pause button on the clip playbar, or a button that was added to the slide, and can be used to trigger the clip presentation to continue. During a pause, users have time to perform specific tasks, view hyperlinks or acquire other information useful for the eLearning session.
  For details, see Adding a Pause Zone on page 115.

- **Click Zone**
  This type of zone on a slide creates a clickable ‘hotspot’. You can set correct, incomplete and/or incorrect outcomes so that when users click the hotspot, depending on their accuracy, they receive a message, receive a score, jump to another clip or slide, and/or have their scores sent to your e-mail address.
  For details, see Adding a Click Zone on page 116.

- **Text Zone**
  With this type of zone on a slide, users can type a combination of letters and numbers in a text box. You can set correct, incomplete and/or incorrect outcomes so that when users type text in the Text zone, depending on their accuracy, they receive a message, receive a score, jump to another clip or slide, and/or have their scores sent to your e-mail address.
  For details, see Adding a Text Zone on page 118.

- **Keystroke Zone**
  With this type of zone in a slide, you can test users on their knowledge of single or multiple keystroke input. You can set correct, incomplete and/or incorrect outcomes so that when users enter a keystroke combination in the Keystroke zone, depending on their accuracy, they receive a message, receive a score, jump to another clip or slide, and/or have their scores sent to your e-mail address.
For details, see Adding a Keystroke Zone on page 120.

- **Question Zone**

  A question zone in a slide can contain one of a variety of single answer, multiple choice or true-false questions for users to answer. You can set correct, incomplete and/or incorrect outcomes so that when users answer the question, depending on their accuracy, they receive a message, receive a score, jump to another clip or slide, and/or have their scores sent to your e-mail address.

  For details, see Adding Question Zones on page 122.

  Note that you can import slides that already contain questions from a Quiz project. See:
  - For details on setting up a Quiz project: Creating Quiz Projects on page 39 in Chapter 3, Creating and Navigating in Clip Projects
  - For details on importing slides from another project: Inserting or Importing Slides to your Clip Project on page 62 in Chapter 3, Creating and Navigating in Clip Projects.

### Attaching Features to Zones

Whenever you add a Click, Text, Question, or Keystroke zone to a slide, you can also:

- Add Events. See Adding Events and Hyperlinks to Slides and Slide Objects on page 87. Event actions include attaching success/error events such as scoring, jumping to another slide, clip or URL, receiving a success/error message, and more.

- Configure messages. See Configuring Correct/Incomplete/Incorrect Messages on page 130

- Set scoring options. See Setting Scoring Options for Interactive Zones on page 134

- Add Audio. See Attaching Audio to Slides or Slide Objects on page 96.
Inserting Interactive Zones on Slides

To insert zones in your slide, you click the appropriate button on the Tools palette at the right edge of your screen.

For information about the Tools palette and its function buttons, see the section Tools Palette Overview on page 68.

⚠️ You can only insert one zone per slide. If you try to insert a second zone, a warning message appears to indicate that if you proceed, the first zone will be replaced by the new zone you want to insert, or that the new zone you are inserting will be inserted on a blank slide, or on a copy of the current slide.

For details about creating each interactive zone, see:
- Adding a Pause Zone on page 115
- Adding a Click Zone on page 116
- Adding a Text Zone on page 118
- Adding a Keystroke Zone on page 120
- Adding Question Zones on page 122
Adding a Pause Zone

1. Select a slide and open it.
2. From the Tools palette, click the Insert PauseZone button 🕒. A red triangle appears at the lower right corner of the slide.

3. Insert a button on the slide that instructs users to click the button to advance the presentation to the next slide. For details, see Adding Buttons to Slides on page 103.

   The red triangle does not appear on your compiled Clip. When playing the clip, the default Pause zone button flickers on the Player bar at the bottom of the slide.

   ![Default Pause button](image)

Users must click the button inserted in Step 3 to advance to the next slide, or click the Default Pause button to advance the presentation to the next slide.

To delete a Pause zone:

1. Click the Insert PauseZone button 🕒. A Warning message appears on the slide.
2. In the Warning message, select the Remove it option, and then click OK. The pause zone is removed from your slide.
Adding a Click Zone

1. Select a slide and open it.
2. On the slide, insert an object like a note, balloon, text frame or shape with instructions about how to use the Click zone. For details on inserting one of these objects, see About Objects on Slides on page 67.
3. From the Tools palette, click the Insert ClickZone button 📀. A Click Zone object (shaded box) displays on the slide, as well as Correct/Incomplete/Incorrect message boxes.
4. Click and drag the Click zone to superimpose it on the area of the slide that you want the user to click. The graphic below shows a slide set up with a possible Click zone, where there zone has already been moved to the area you want the user to click:
5 To modify the appearance of the Click zone area, select and right-click the Click zone and, from the menu list, select **Modify Click Area.** The **Click Area** dialog box opens.

In this dialog box, you can configure how the background color, opacity, and border color and thickness of the Click zone displays. There are three scenarios in which you can configure Click zone appearance: under normal circumstances; when a user rolls a mouse over it; and when a user clicks it.

Make changes as required in each of the **Normal**, **Rollover**, and/or **Selected** areas of the dialog box as follows:

- Click the Background Fill icon, and select or customize a color for the background.
- Type or select a number for the opacity in the Opacity box. The lower the opacity number, the more transparent the Click zone, with a value of 0 leaving the Click zone transparent, and a value of 100, solid.
- Click the Border Color icon, and select or customize a color for the border. Then type or select a number in the Border Thickness box.

6 To attach an action to the Click zone, see **Adding Events and Hyperlinks to Slides and Slide Objects** on page 87.

7 To set correct, incomplete, and/or incorrect message options, see **Configuring Correct/Incomplete/Incorrect Messages** on page 130.

8 To set scoring for the Click zone, see **Setting Scoring Options for Interactive Zones** on page 134.

9 For details on modifying the Click zone by moving it, resizing it, deleting it, and more, see below, **Modifying zones** on page 136.
Adding a Text Zone

1 You can make the Text zone case sensitive, or create a password field

1 Select a slide and open it.
2 On the slide, insert a note, balloon or text frame with instructions indicating the task the user must perform using the Text zone. For details on inserting one of these objects, see About Objects on Slides on page 67.
3 Click Insert TextZone button  on the Tool palette. The Text zone displays with a text box and correct/incomplete/and/or incorrect text boxes.

![Diagram of adding a text zone with instructions on selecting a slide and inserting a note, balloon, or text frame with instructions for the Text zone. The Text zone displays a text box and correct/incomplete/and/or incorrect text boxes.]
4 To configure the Text zone, double click it. The **Modify Text Field** dialog box opens.

In the dialog box, do the following:

a. In the **Correct Answers - One Per Line** text box, use one line to type the text that you want the user to correctly reproduce during the clip presentation. This step is mandatory.

   If multiple answers are required, press **Enter** on your keyboard, and type the subsequent text on the next line. Repeat for each line of text.

b. If you want the correct text to be case sensitive, click the **Case Sensitive** box (optional).

c. To select the key the user must press when finished typing the text, click the **Submit Key** box, and select an option, such as **Enter** or **Tab**. This step is mandatory.

d. If you want to use the text wrap feature for the text, click the **Wrap Text** box (optional).

e. If you want a password field to appear when the user is typing the text, click the **Password Field** box (optional).

   If you select this option, when a user types text in the Text zone, the text appears as a group of asterisks (********).

5 To attach an action to the Text zone, see **Adding Events and Hyperlinks to Slides and Slide Objects** on page 87.

6 To set the correct, incomplete and/or incorrect message options, see **Configuring Correct/Incomplete/Incorrect Messages** on page 130.

7 To set scoring options for the Text zone, see **Setting Scoring Options for Interactive Zones** on page 134.

8 For details on modifying the Text zone by moving it, resizing it, deleting it, and more, see below, **Modifying zones** on page 136.
Adding a Keystroke Zone

1. Select a slide and open it.
2. On the slide, insert a note, balloon or text frame with instructions indicating the task the user must perform using the Keystroke zone. For details on inserting one of these objects, see About Objects on Slides on page 67.

To help users position their mouse cursors in the correct spot before pressing a keystroke combination, place the note, balloon or text frame directly beneath the Text zone, as shown in the graphic below.

3. Click the Insert KeystrokeZone button on the Tool palette. The Keystroke zone displays, showing the default keystroke, along with Correct, Incomplete, and/or Incorrect message boxes.
4 To define the keystroke action you want your viewer to execute, double-click the default keystroke button or, on the project toolbar above the slide, click the Define Keystroke button. The Define Keystroke dialog box opens.

5 In the dialog box, click the Define button to change the default Pause keystroke. A flashing Press Any Keys appears below the Keystroke box.

6 Press a key or combination of keys on your keyboard, then click OK. The new key combination replaces the PAUSE key on your slide.

7 To attach an action to the Keystroke zone, see Adding Events and Hyperlinks to Slides and Slide Objects on page 87.

8 To set the correct, incomplete and/or incorrect message options, see Configuring Correct/Incomplete/Incorrect Messages on page 130.

9 To set scoring options for the Keystroke zone, see Setting Scoring Options for Interactive Zones on page 134.

10 For details on modifying the Keystroke zone by moving it, resizing it, deleting it, and more, see below, Modifying zones on page 136.
Adding Question Zones

When you add a Question Zone, you have the same range of question type options that are available when you are creating a Quiz project (see Creating Quiz Projects on page 39 in Chapter 3, Creating and Navigating in Clip Projects).

Adding a question zone:

1. Select a slide and open it.
2. On the Tools palette, click the Insert Question button . The Question dialog opens, with a list of the types of questions available.

3. Select the question type you want for your first slide, for example Multiple Choice - Single Answer and type the question or statement in the Question box at the bottom of the dialog box. Then click OK to close the dialog box.

The question, with Correct/Incomplete/Incorrect message boxes appears on your slide. For example, a simple multiple choice question appears, by default, with a question box which contains the question (that you typed in the dialog box in this
step), three rows of **Choice** text boxes next to radio buttons, a **Submit** button, and Correct/Incomplete/Incorrect message boxes.

![Image of a question with choices and submit button]

---

° By default, the Answer text box, **Submit** button, and the Correct/Incomplete/Incorrect message boxes always appear when you insert a Question zone. Only the answer area’s appearance varies, as it depends on the question type you chose.

4 To reposition elements in the Question zone to where you want them to display on your slide, click each element and drag it to the appropriate spot.

**Working with different question types:**

The table below describes all Content Producer Author question options as follows:

- **Question Type name**
- **Description** (what you use the question for, and the initial appearance of the answer area on the slide)
- **Next Steps** (how to configure answers/ratings for each question type)
Once you finish reviewing the table and its instructions, go to the procedure **Modifying Question zones** on page 128.

### Question Type Table

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
<th>Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Short Answer - Fill in the Blank</strong></td>
<td>A ‘fill in the blank’ question that has a single answer. <em>Example:</em> The square root of 81 is _____</td>
<td>Do the following: 1 In the question text box, type a question. 2 To type the answer in the answer text box, select the text box, double-click inside it, then begin typing the answer text. 3 To change the answer text and how it is displayed, right-click the text box, and choose <strong>Modify Choice</strong>. Then, in the <strong>Modify Text Field</strong> dialog box, change the question text and such options as the submit key or text wrap option. 4 To change the style you want for the text field, right-click the text box and choose <strong>Choice Type &gt; Text Field</strong>. From the dialog box, select the style you want for the text field.</td>
</tr>
<tr>
<td><strong>Short Answer - Selection From List</strong></td>
<td>A question with a single answer, selectable from a given list. <em>Example:</em> Which of these planets is the largest? <em>Choices:</em> Pluto, Jupiter, Mars.</td>
<td>Do the following: 1 In the question text box, type a question. 2 Select the answer combo text box, then double-click inside it. 3 In the <strong>Modify ComboBox</strong> dialog box, click to add the first possible answer in the list. A check box appears in the Correct column, and the possible answer in the Value column. 4 Repeat Step 2 for each selection you want to include. 5 In the <strong>Correct</strong> column, click the check box beside the correct answer. 6 Click OK to save your answer selection, and to close the dialog box.</td>
</tr>
<tr>
<td><strong>Short Answer - Rating</strong></td>
<td>A question that allows the respondent to choose a single answer on a given scale. <em>Example:</em> Rate your dining experience in New York City. <em>Choices:</em> 1, 2, 3, 4 or 5 stars.</td>
<td>Do the following: 1 In the question text box, type a question. 2 To modify rating values, select and double-click the rating symbol box. In the <strong>Modify Rating</strong> dialog box, type or select a number in the Correct Rating box and/or the Maximum Rating box. Click OK to save and close the box. 3 To modify rating symbol values, repeat step 1. 4 To change the rating symbol style, right-click the rating symbol box and choose <strong>Choice Type &gt; Rating</strong> and, in the <strong>Rating Style</strong> dialog box, select a rating symbol style. Click OK to save and close.</td>
</tr>
</tbody>
</table>
### Question Type

<table>
<thead>
<tr>
<th>Description</th>
<th>Next Steps</th>
</tr>
</thead>
</table>
| **Short Answer - Essay** | Do the following:  
1. In the question text box, type a question.  
2. Select and double-click the answer text box. In the Modify Text Field dialog box, type the correct answer in the text box.  
3. Make sure that the Wrap Text option is checked, so that longer sentences automatically wrap around within the answer text box.  
4. To modify the text, repeat step 1.  
5. To select a text box style, right-click the text box and, from the menu list, choose Choice Type > Text Field. From the dialog box, select the style you want for the text field. Click OK to save and close. |
| **Multiple Choice - Single Answer** | Do the following:  
1. In the question text box, type a question.  
2. Select a text box beside a radio button, double-click inside it, then type your text.  
3. Repeat for each text box.  
4. To set the correct answer, click the radio button beside the correct text.  
5. To insert an additional answer selection row, on the Toolbar above the slide, click the Add Choice button . An additional row appears. Repeat for each additional row you want to add.  
6. To delete a row, select the text box, and press Del on your keyboard. |
| **Multiple Choice - Multiple Answers** | Do the following:  
1. In the question text box, type a question.  
2. Follow the instructions as for Multiple Choice - Single Answer question.  
3. To set multiple answers for this question, click the radio button beside each of the text boxes that contains a correct answer. |

**Appearance**

- By default, beneath the question, a large answer text box appears. Type the essay answer in the text box.

**Example:** 2+2 equals...  
**Choices:** 1, 2, 3, 4, or None of the Above

- By default, beneath the question, a large answer text box appears. Type the essay answer in the text box.

**Appearance**

- By default, beneath the question, a large answer text box appears. Type the essay answer in the text box.

**Example:** Pick a number that is greater than 5.  
**Choices:** 6, 7, 8, 9, or All of the Above

- By default, beneath the question, a large answer text box appears. Type the essay answer in the text box.

**Appearance**

- By default, beneath the question, a large answer text box appears. Type the essay answer in the text box.
## Chapter 6 - Working With Interactive Zones

### Inserting Interactive Zones on Slides

- **Multiple Choice - Fill in the Blanks**
  - **Description:** A question containing more than one ‘fill in the blanks’. *Example:* Roses are _____ and Violets are ______.
  - **Appearance**
    - By default, three simple answer text boxes appear beneath the question text box. For this type of question, type a correct answer in each text box (the ‘blanks’).
  - **Next Steps:**
    1. In the question text box, type a question.
    2. To type answers in one of the answer text box, select the text box, double-click inside it, then begin typing the answer text.
    3. Repeat for each text box, as required.
    4. To change answer text and how it is displayed, right-click a text box, and choose Modify Choice. Then, in the Modify Text Field dialog box, change the question text and such options as the submit key or text wrap option.
    5. To change the style you want for all text boxes, right-click any text box and choose Choice Type > Text Field. From the dialog box, select the style you want for the text field.
    6. To add an additional text box (for an additional ‘blank’), on the Toolbar above the slide, click the Add Choice button. An additional row appears. Repeat for each additional row you want to add.

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
<th>Next Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Multiple Choice - Selection from Lists</strong></td>
<td>A question where respondents select answers from a list of choices. <em>Example:</em> What is the capital of each of these countries? Japan - <em>Choices:</em> Tokyo, Osaka, Kyoto U.S.A. - <em>Choices:</em> New York City, Washington D.C., San Francisco</td>
<td>Do the following: 1. In the question text box, type a question. 2. Select a combo text box, then double-click inside it. 3. In the Modify ComboBox dialog box, click to add the first possible answer in the list. A check box appears in the Correct column, and the possible answer in the Value column. 4. Repeat Step 2 for each possible selection you want to include. 5. In the Correct column, click the check box beside the correct answer. 6. Click OK to save your answer selection, and to close the dialog box. 7. Repeat steps 1 to 5 for each combo text box. 8. To add an additional combo text box, on the Toolbar above the slide, click the Add Choice button. An additional row appears. Repeat for each additional row you want to add.</td>
</tr>
</tbody>
</table>
Multiple Choice - Rating

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
<th>Next Steps</th>
</tr>
</thead>
</table>
| **Appearance**        | By default, three rows, each with a choice text box and a box containing rating symbols, appears beneath the question text box. Type text relating to each item you are rating, and modify rating values as required. | Do the following:  
1. In the question text box, type a question.  
2. Select a choice text box, and double-click inside it. Type the text for the item being rated.  
3. Repeat for each item being rated.  
4. To modify text appearance, select the text and use the Text toolbar above the slide.  
5. To modify rating values, select and double-click a rating symbol box. In the Modify Rating dialog box, type or select a number in the Correct Rating box and/or the Maximum Rating box. Click OK to save and close the box.  
6. Repeat as required for each item you are rating.  
7. To add an additional item with rating symbols, on the Toolbar above the slide, click the Add Choice button . An additional row appears. Repeat for each additional row you want to add.  
8. To change the rating symbol style, right-click the rating symbol box, choose Choice Type > Rating and, in the Rating Style dialog box, select a rating symbol style. Click OK to save and close. All rating symbols for this question are updated. |
## Chapter 6 - Working With Interactive Zones

### Inserting Interactive Zones on Slides

#### Modifying Question zones

- To modify the **Submit** button, and give it a different button style or wording, see [Adding Buttons to Slides](#) on page 103.

5. To attach rollover areas to elements of the Question zone such as the Question text box or Correct/Incomplete/Incorrect message boxes, see [Attaching Rollover Areas to Slide Objects](#) on page 101. Once you attach a rollover area, you can then attach an event to the area, so that when a user’s mouse rolls over the area, an action you

<table>
<thead>
<tr>
<th>Question Type</th>
<th>Description</th>
<th>Next Steps</th>
</tr>
</thead>
</table>
| **Multiple Choice - True/False** | Respondents specify whether a statement is true or false.  
*Example:* Mars is the planet closest to the sun.  
*Choices:* True, False  
**Appearance**  
By default, True and False options are displayed below the question text box. | Do the following:  
1. In the question text box, type a question.  
2. Click the True or False radio button to set the correct response.  
3. To add additional response options (for example, Not Applicable), on the Toolbar above the slide, click the Add Choice button. An additional row appears, with a radio button, and a text box. Modify the text in the new text box as required. |

| **Likert Scale** | A statement where respondents specify their level of agreement with a statement.  
*Example:* The customer service representative was very helpful.  
*Choices:* Strongly Disagree, Disagree, Somewhat Disagree, Agree, Strongly Agree  
**Appearance**  
By default, three text boxes for items to be rated are listed, with five columns, with each containing radio bullets. The five column, by default, contain text boxes labelled Strongly Disagree, Disagree, Somewhat Disagree, Agree, Strongly Agree. | Do the following:  
1. In the question text box, type a question.  
2. Select a text box to use for an item to be rated, and double-click inside it. Type the text naming the item being rated.  
3. Repeat for each item being rated.  
4. To change the headings for the rating columns, select the text box you want to modify, double-click inside it, and type the new column heading text.  
5. To modify text appearance, select the text and use the Text toolbar above the slide.  
6. To add an additional item to be rated, on the Toolbar above the slide, click the Add Row button. An additional row appears. Repeat for each additional row you want to add.  
7. To add an additional rating column, click the Add Column button. An additional column appears. Repeat for each column.  
8. To change the rating symbol style, right-click the rating symbol box, choose **Choice Type > Rating** and, in the **Rating Style** dialog box, select a rating symbol style. Click **OK** to save and close. All rating symbols for this question are updated. |
have configured (for example, jumping to a new browser window to view a URL) can occur.

6 To attach an event to elements in the Question zone such as radio buttons or check boxes in multiple choice questions, see Adding Events and Hyperlinks to Slides and Slide Objects on page 87.

7 To set the correct, incomplete and/or incorrect message options for the Question zone, see Configuring Correct/Incomplete/Incorrect Messages on page 130.

8 To set scoring options for the Question zone, see Setting Scoring Options for Interactive Zones on page 134.

9 For details on modifying the Question zone by moving it, resizing it, deleting it, and more, see below, Modifying zones on page 136.
Configuring Correct/Incomplete/Incorrect Messages

When you insert an interactive zone on a slide (such as a Click zone, Text zone, Keystroke zone, or Question zone), by default the interactive zone includes a correct, incomplete, and incorrect message box.

By default, each interactive zone is configured so that after a user performs an action, two events occur:

- a correct, incomplete, or incorrect message is displayed, depending on the outcome of the user's action.
- following the message display, the clip advances to the next slide.

For details on events, see Adding Events and Hyperlinks to Slides and Slide Objects on page 87.

You can change the events that occur after a user action - for example, you can add a Show Score action to display after a correct action, and you can also change message wording, appearance, and position.

See:
- Changing Default Interactive Zone Events on page 130
- Changing Message Wording on page 132
- Changing the Message Background Color on page 132
- Moving Message Boxes on page 133
- Resizing Message Boxes on page 133

Changing Default Interactive Zone Events

1. Open a slide, and insert an interactive zone on it (for details, see Inserting Interactive Zones on Slides on page 114.)
2 Above the slide on the Toolbar, click the Event button . The Slides Events dialog box opens.

3 Click the On Correct, On Incomplete, or On Incorrect tab. Note that by default, each of the On Correct tab, the On Incorrect tab, and the On Incomplete tab contain the following actions:

<table>
<thead>
<tr>
<th>Tab</th>
<th>Action</th>
</tr>
</thead>
</table>
| On Correct       | - Display Object: Correct Message action. This action is triggered by a correct response, and results in a message box on the slide that indicates to the user that the response is correct.  
                   - Continue action. This action occurs after the Correct message box displays, and allows the clip to advance to the next slide. |
| On Incorrect     | - Incorrect Attempt: All - Display Object. This action is triggered by an incorrect response, and results in a message box on the slide that indicates to the user that the response was incorrect.  
                   - Incorrect Attempt: Last - Continue action. This action occurs after the Incorrect message box displays. By default, the response attempt is set to Last, and the action allows the clip to advance to the next slide. |
| On Incomplete    | - Display Object: Incomplete Message action. This action is triggered by an incomplete response, and results in a message box on the slide that indicates to the user that the response was incomplete. There is no Continue action, as the user is expected to complete the response. |

4 To change a default action, double-click it, and in the Action dialog box, select and configure a different action, as described in Step 6.
5 To add an additional action to the tab, on the right panel, click the green plus sign. The **Action** dialog box opens.

6 In the dialog box, click the arrow beside the **Action Type: Select the action type from the list** box, and then select an action from the list. Depending on the action you select, the dialog box refreshes, prompting you to complete additional steps. For a list of possible actions, their description, and how to configure them, see the [Event Action Type Table](#) on page 91.

Once you finish adding the new action, it is listed below the first two actions. Actions associated with an interactive zone occur in the order in which they are listed.

7 To change the action order, select an action to move it down, and click the **Move Down** button.

8 To modify an action, from the **Action** list, select the action you want to modify, and click the pencil button on the right panel of the dialog box. The **Action** dialog box, containing the information you had configured for the action, opens. Make changes as required.

9 To delete an action, select the action on the tab, and click the delete button on the right panel of the dialog box. The action disappears from the list.

### Changing Message Wording

1 Open a slide and insert an interactive zone.

2 Select the message box in which you want to change the wording, double-click inside it, and type the new wording you want to use.

3 To change text appearance and size, select the text inside the message box and, using the Text toolbar dialog above the slide, adjust font type, size, style, text alignment, and so on, as required.

    For details on the text toolbar, see [Using the Text toolbar](#) on page 74.

### Changing the Message Background Color

1 Open a slide and insert an interactive zone.

2 Select the message box for which you want to change the background color, and click the Background Color button on the toolbar to display the color palette.

3 From the color palette, select the color that you want as the balloon or note’s background color, or create a custom color.

4 Click **Apply** and then **OK** to apply the color to your object, and to close the dialog box.

5 For more details on setting background color, see [Changing a note or balloon’s background color](#) on page 70.
Moving Message Boxes

Select each box individually, then click and drag to a new location. Release to drop each box into place.

Resizing Message Boxes

Select each box individually, then position your mouse pointer over a grab handle. Drag it to resize the text box.
Setting Scoring Options for Interactive Zones

Content Producer interactive clips are often delivered by a learning management system (LMS) that is used to evaluate and record the learning progress of the students who view the clips and complete various actions and quizzes.

In order to evaluate user actions, by default, every interactive zone is configured with pre-set scoring options.

When a user successfully completes an action related to an interactive zone - for example, successfully answering a question - the action receives a point score. This point score can then be processed as part of a learning evaluation.

When configuring an interactive zone, you can change the pre-set scoring options such as the number of points assigned to an interactive zone, the number of attempts the user is allowed to try and complete the action or answer the question, and the duration allowed for completing the action or answering the question.

See:
- Changing the number of points assigned to an action or question in an interactive zone on page 134
- Changing the number of attempts a user is allowed to complete an action or a question on page 135
- Changing the duration allowed for a user to complete an action or a question on page 135

Changing the number of points assigned to an action or question in an interactive zone

1. Open a slide and insert an interactive zone - a Click zone, Text zone, Keystroke zone, or a Question zone. For details on inserting an interactive zone, see Inserting Interactive Zones on Slides on page 114.

2. Above the slide, click the Scoring button. The Score dialog box opens.
3 In the **Points** area, type or select the number of points you want to assign to the action or question.

4 Click **OK** to close the dialog box.

**Changing the number of attempts a user is allowed to complete an action or a question**

1 Open a slide and insert an interactive zone - a Click zone, Text zone, Keystroke zone, or a Question zone. For details on inserting an interactive zone, see [Inserting Interactive Zones on Slides](#) on page 114.

2 Above the slide, click the **Scoring** button. The **Score** dialog box opens.

3 In the **Attempts** area, type or select the number of attempts a user is allowed to complete the action or question.

4 If you want users to be able to re-attempt an action or question when navigating backwards in a clip, click the **Question can be reanswered on backwards navigation** box.

5 Click **OK** to close the dialog box.

**Changing the duration allowed for a user to complete an action or a question**

1 Open a slide and insert an interactive zone - a Click zone, Text zone, Keystroke zone, or a Question zone. For details on inserting an interactive zone, see [Inserting Interactive Zones on Slides](#) on page 114.

2 Above the slide, click the **Scoring** button. The **Score** dialog box opens.

3 In the **Time** area, check the **Enable a time limit for the question**.

4 Type or select the hours, minutes, and seconds for the attempt duration in the **Hours**, **Minutes**, and **Seconds** boxes.

5 Click **OK** to close the dialog box.
Modifying zones

You can modify zones by moving zone areas/objects to another part of the slide, resizing zone areas, or deleting a zone.

See:
- Moving a zone area/object on page 136
- Resizing a zone area on page 136
- Deleting a zone on page 136

Moving a zone area/object

Position your mouse over the shaded box, text frame, keystroke image or quiz questions and answers. Click and drag each object to a new location.

Resizing a zone area

Click a zone area, such as the shaded box in a Click zone or the text box in a Text zone, to reveal the grab handles. Position your mouse over a grab handle and drag the grab handle to resize the box.

Deleting a zone

1. On the Tool palette, select the same zone button that you used to insert a zone, such as the **Insert ClickZone** button if you had inserted a Click zone.
2. In the **Warning** message, select the **Remove it** option, and then click **OK**. The zone is removed from your slide.

💡 Alternatively, right-click the zone you want to delete and, from the menu, choose **Delete**.
You use Content Producer’s Editor component to open existing audio/visual media files, or to record media files. Use Editor to create slides that can then be incorporated in the clip projects you create with Content Producer Author.

This chapter contains the following sections:

- About Editor, page 138
- Opening existing audio/video media files, page 141
- Recording an audio/video session, page 143
- Saving audio/video media files, page 149
- Creating Slides in Editor, page 150
- Exporting slides to Content Producer Author, page 155
About Editor

With Content Producer Editor, you can import AVI/WAV files, such as recorded interactions in your call center from other products in the Impact 360 product suite, such as Quality Monitoring 10 SP3 or later, Quality Monitoring 7.8.1, ContactStore, TDM Recorder and Balance R5.

You can also record a session in real time using an application running on your computer.

Once you import or create an audio/video media file, you can select and capture audio and video segments to export as slides to Content Producer Author. In Author, these slides can be enhanced and edited, then compiled as Learning clips.

The following describes the general process for using Content Producer Editor:

1. Import or record an audio/video file (in *.avi or *.wav file format). See Opening existing audio/video media files on page 141 or Recording an audio/video session on page 143.

2. Playback the audio/video file (video clip) and select frames to be inserted as slides. See About Playback, Slide and Movie Timeline controls on page 150 and Creating a slide on page 153.

3. Export slides to Content Producer Author. See Exporting slides to Content Producer Author on page 155.


See:
- Starting Content Producer Editor on page 139
- Toolbar overview on page 139
- Opening existing audio/video media files on page 141
- Recording an audio/video session on page 143
- Saving audio/video media files on page 149
- Creating Slides in Editor on page 150
- Exporting slides to Content Producer Author on page 155
Starting Content Producer Editor

For details on starting Content Producer Editor and navigating in the main window, see Chapter 2, Getting Started and Navigation, page 19.

When the Content Producer Editor window opens, use the Editor toolbar (shown below) to select or capture audio/video media.

Toolbar overview

Using Content Producer Editor toolbar buttons, you can open and save files, select video clips to edit, record actions on your system and export video clip segments as slides to Content Producer Author:

Editor toolbar functions

<table>
<thead>
<tr>
<th>Toolbar buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NEW PROJECT</strong></td>
<td>Click to begin a new Editor project. If you already have a project open in the Editor window, a message displays, warning you to save the project before opening a new one. Otherwise the new project replaces the project you were working on.</td>
</tr>
<tr>
<td><strong>OPEN PROJECT</strong></td>
<td>Click to open an existing, saved Editor project (in *.qvm file format)</td>
</tr>
<tr>
<td><strong>SAVE PROJECT</strong></td>
<td>Click to save the project you are working on</td>
</tr>
<tr>
<td><strong>SELECT MEDIA</strong></td>
<td>Click to select existing audio/video media that you can edit. These media must be in *.avi or *.wav file format.</td>
</tr>
<tr>
<td><strong>CAPTURE MEDIA</strong></td>
<td>Click to set up a capture session where you record actions on your system. Options are to record video and audio combined, video only, or audio only.</td>
</tr>
</tbody>
</table>
## Editor toolbar functions

<table>
<thead>
<tr>
<th>Toolbar buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZOOM VIDEO</td>
<td>Select a percentage by which to shrink or enlarge the frame view</td>
</tr>
<tr>
<td>EXPORT TO CONTENT PRODUCER AUTHOR</td>
<td>Click to export the slides you created in Editor to Author, where they can be compiled into a clip.</td>
</tr>
<tr>
<td><strong>Note</strong>: If you have not created any slides and you click this button, a message appears to indicate that there are no slides to export.</td>
<td></td>
</tr>
</tbody>
</table>
Opening existing audio/video media files

With Content Producer Editor, you can import audio/video media files such as Quality Monitoring 10 SP3 or later lessons or Quality Monitoring 7.8.1 call center recordings. You can then edit a media file by selecting segments of it and creating slides. The slides can then be exported to Content Producer Author, with which you can create learning clips.

See:
- Importing an audio/video media file on page 141

Importing an audio/video media file

1. Click the Select Media button on the toolbar. The Select Media File to Edit window opens.
2. Locate and select the audio/video media file (in *.avi or *.wav file format) you want to import, then click Open. The Content Producer Editor window displays the first frame of the media file:

- Video with audio, or video only files displays in a way similar to the example below, with Movie Timeline, playback and slide controls activated:
If you open a file with audio only, it displays in the Editor window in a way similar to this example:

3 To edit a video and create slides, see below, Creating Slides in Editor on page 150.
Recording an audio/video session

With Content Producer Editor, you can record a video of an application running on your own system. You can then play back the recording and select segments of it and create slides.

These slides can then be exported to Content Producer Author. You can use them in Author to create learning clips.

See:
- Setting your recording options on page 143
- Recording a video clip on page 146

Setting your recording options

Click the Capture Media button on the Content Producer Editor toolbar to display the Capture Options dialog:

To select a video and/or audio capture option

Select the capture mode option for your recording. For example, select the Video and Audio option if you want your recording to be an audio/video media file.
To select an image source option

Select one of the options in the **Image Source** area:

- If you select the **Application** option: click \( \text{\textless} \) inside the box to display the list of applications currently running on your system. Select the application that you want to record as a video. Once you start recording, the application’s window displays on your desktop.

  If you want to record an application not currently running on your desktop, start the application before beginning the audio/video capture process.

- If you select the **Window** option: before you start recording, the current application that is running displays and you can expand the part of the window you want captured or move to another part of the window.

- If you select the **Area** option: before you start recording, the current application that is running displays, and you can set the video capture area by clicking and dragging the crosshair that appears in the window.

- If you select the **Screen** option: once you start recording, the recording captures all video on your desktop, including the application that is currently running and such elements as menu bars and the Windows task bar.

To select an audio source option

Select an option in the **Audio Source** area. For example, if you choose the **Microphone** option, Editor captures the audio through the microphone attached to your computer.

The **Audio Source** area is not enabled if you selected the **Video Only** option in the **Capture Media** area.

If you are using the Windows Vista operating system, the only audio source shown in the **Audio Source** area is **Master Volume**.

To set a file destination for the recording

To save the video clip you are about to capture in *.avi or *.wav format, click \( \ldots \) beside the **Destination** box. In the Save As window, locate the folder in which you want to save your file, type its name in the **File name** box, then click **Save**.
By default, if you chose **Video and Audio** or **Video Only** when choosing a media capture option, your video clip is saved in *.avi* file format. If you chose **Audio Only**, the default file format is *.wav.*
Recording a video clip

1. When you finish selecting recording options, click OK. The following changes occur on your desktop:

   - The image source you selected replaces the Editor window:
     - If you selected the **Application** or **Screen** image source option, the Content Producer Editor - Capture dialog opens right away.
     - If you selected the **Window** image source option, a red border surrounds part of the application window and an instructional message appears. Click inside the red border to include the part of the window you want recorded. The Content Producer Editor - Capture dialog opens when you release the mouse button:

   ![Instructional message](image1)

   ![Red border](image2)

   - If you selected the **Area** image option, the cursor becomes a crosshair and an instructional message appears. Click and drag the crosshair to expand to the area you want to include in your video clip. The Content Producer Editor - Capture dialog opens when you release the mouse button:
The **Content Producer Editor - Capture** dialog when it opens:

- The Editor icon displays in the desktop’s system tray, which is in the lower right corner of the desktop.
2. In the **Capture** dialog box, make sure that the **Hide this window while capturing** check box is flagged (otherwise the dialog is visible on your video).

3. Click the **Start** button.

4. Perform the tasks in the application that you want to record. When you finish, click the Editor icon to pause the recording. The **Content Producer Editor - Capture dialog** re-opens.

5. Click the Editor icon in the task tray in the lower right corner of your desktop. The **Content Producer Editor - Capture** dialog box opens.

6. In the dialog box, click **Stop** to the recording. The Editor window re-opens, displaying the first frame of your new video.

7. To edit the new media file, see **Creating Slides in Editor** on page 150.

8. To save the new media file, see **Saving audio/video media files** on page 149.
Saving audio/video media files

When you are finished importing/recording a media file or editing it, you can save it as an Editor project file, but you can also, for example, turn an audio/video media file into an audio (*.wav) file only.

See:
- Saving audio/video files on page 149
- Saving an audio/video media file as an audio file only on page 149

Saving audio/video files

1. Select File>Save Project or click the Save Project button on the toolbar. The file is saved in *.qvm file format to the destination you specified when setting the project’s capture options.

2. To close the current window and start a new project, select File>New Project or click the New Project button on the toolbar.

Note: If a project is open in the Editor window when you start a new project, a message prompts you to save the existing project. If you don’t, the new project window opens, and you lose the changes you made to the previous project.

Saving an audio/video media file as an audio file only

1. Select File>Save Media As. The Save Media [File Name] As window opens.

2. Type a new name for the file in the File name box, and in the Save as type box, select *.wav as the file format.

3. Click Save.
Creating Slides in Editor

Once you retrieve an existing audio/video media file, or create one using Editor’s recording feature, you can play back the video clip and use the Movie Timeline and Slide controls to select and insert slides.

When you finish, you export the slides you created to Content Producer Author. In Author, you can add notes and interactive zones to the slides and compile them as a Clip presentation.

See:
- About Playback, Slide and Movie Timeline controls on page 150
- Playing a video clip on page 153
- Creating a slide on page 153

About Playback, Slide and Movie Timeline controls

The Playback, Slide and Movie Timeline Display control buttons are located on the bar above the Movie Timeline, which displays at the bottom of the Editor window. These controls are activated once the first frame of an audio/video media file opens in Editor:
- Playback controls allow you to control how you play back the video clip you imported or recorded.
- Slide controls allow you to select frames from a video clip while it plays, and set them as slides. With these controls you can also preview and navigate between the slides.
- Movie Timeline controls allow you to compress or expand the Movie Timeline as you back a video clip.

Control buttons are active/disabled depending on the action you take. The graphic and table below describe these controls in detail.
### Control button functions

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PLAYBACK TIME ELAPSED</strong></td>
<td>Shows the amount of time that's elapsed since your video clip began to play.</td>
</tr>
<tr>
<td><strong>PLAYBACK CONTROLS</strong></td>
<td></td>
</tr>
<tr>
<td>FIRST FRAME</td>
<td>Click to return to the first frame of the video</td>
</tr>
<tr>
<td>PREVIOUS FRAME</td>
<td>Click to go to the previous frame of the video</td>
</tr>
<tr>
<td>PLAY</td>
<td>Click  to play the video,  .to pause it</td>
</tr>
<tr>
<td>NEXT FRAME</td>
<td>Click to move to the next frame of the video</td>
</tr>
<tr>
<td>LAST FRAME</td>
<td>Click to go to the last frame of the video</td>
</tr>
<tr>
<td><strong>SLIDE CONTROLS</strong></td>
<td></td>
</tr>
<tr>
<td>PREVIOUS SLIDE</td>
<td>Click to go the previous slide</td>
</tr>
<tr>
<td>PREVIEW SLIDE</td>
<td>Select a slide you inserted and click the Preview Slide button to preview it.</td>
</tr>
<tr>
<td>NEXT SLIDE</td>
<td>Click to go to the next slide</td>
</tr>
<tr>
<td>INSERT SLIDE</td>
<td>Click once you select a frame to insert as a slide.</td>
</tr>
<tr>
<td>REMOVE SLIDE</td>
<td>Click to remove a slide.</td>
</tr>
<tr>
<td><strong>TIMELINE DISPLAY CONTROLS</strong></td>
<td></td>
</tr>
<tr>
<td>ZOOM TIMELINE OUT</td>
<td>Click to compress the Movie Timeline Display and show larger intervals of time. For example, you can compress the timeline from 10 second intervals to one minute intervals. Each time you click this button, the slider moves one notch to the left.</td>
</tr>
<tr>
<td>ZOOM TIMELINE IN</td>
<td>Click to expand the Movie Timeline Display and show smaller intervals of time. For example, you can expand the timeline from one minute intervals to 10 second intervals. Each time you click this button, the slider moves one notch to the right.</td>
</tr>
<tr>
<td>SLIDE BAR</td>
<td>Drag the slider on the Slide Bar left to show a compressed timeline with larger time intervals, or drag it right to show an expanded timeline with shorter time intervals.</td>
</tr>
</tbody>
</table>
Control button functions

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Functions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Movie Timeline Display</strong></td>
<td></td>
</tr>
<tr>
<td>In point</td>
<td>The In point marker indicates where the audio portion of the slide you inserted begins.</td>
</tr>
<tr>
<td>Out point</td>
<td>The Out point marker indicates where the audio portion of the slide you inserted ends.</td>
</tr>
<tr>
<td>Player head</td>
<td>Once you start to playback the video clip, the player head moves along the Movie Timeline. Or, drag the player head to where you want to insert a slide.</td>
</tr>
<tr>
<td>Slide marker</td>
<td>The slide marker marks the point where the slide is inserted along the movie line. Note that the audio portion may extend beyond the point where the slide is inserted.</td>
</tr>
</tbody>
</table>
Playing a video clip

1. Click the Play button on the Playback control bar below the first frame of the video clip. The Movie Timeline player head moves along the timeline, and the Play button changes to a Pause button.

2. To pause the video clip, click the Pause button.

Navigating between frames

- Click the First Frame button on the Playback control bar to return to the start of the video clip (the first frame).
- Click the Last Frame button on the Playback control bar to go to the end of the video clip.
- Click the Previous Frame or Next Frame button to go to the previous or next frame in the video clip.
- To restart the clip, click the Play button again.

Compressing or expand the Movie Timeline.

- To compress the Movie Timeline, and show larger intervals of time, click the Zoom Timeline Out button. For example, time intervals along the timeline change from 10 second intervals to one minute intervals.
- To expand the Movie Timeline and show smaller intervals of time, click the Zoom Timeline In button. For example, time intervals along the timeline can change from one minute intervals to 10 second intervals.

Alternatively, pull the slider in the slider bar left to compress or right to expand time intervals along the timeline.

Creating a slide

You can create and insert a slide while the video clip is playing, or you can drag the Movie Timeline player head to a location on the timeline where you want to create and insert a slide.

See:
- Creating and insert a slide on page 154
- Navigating between slides on page 154
- Previewing a slide on page 154
- Removing a slide on page 154
Creating and insert a slide

1. Open the audio/video clip from which you want to create slides.
2. Create and insert new slides in one of two ways:
   - As the video clip plays, click the Movie Timeline player head as it moves through the frame you want to select as a slide. The video clip stops playing, and some of the Slide controls are activated.
   - OR -
   - Without playing the video clip, drag the Movie Timeline player head to a spot on the timeline where you want to select a frame to insert as a slide. Some of the slide controls are activated.
3. Click the Insert Slide button on the Slide control bar. A marker appears on the Movie Timeline at the slide’s location each time you insert a slide, as do the In/Out audio points.
4. Resume playing the audio/video clip or dragging the Movie Timeline player head to the next spot where you want to select and create a slide.
5. When you finish, make sure to save your project.

Navigating between slides

Click the Previous Slide or Next Slide button to go to the previous or next slide that you inserted along the Movie Timeline.

Previewing a slide

Navigate to the slide you want to preview, and click the Preview Slide button.

Removing a slide

Navigate to the slide you want to remove, and click the Remove Slide button. The slide is deleted.
Exporting slides to Content Producer Author

Once you finish selecting the video segments you want to use as slides in an eLearning presentation, you are ready to export the new slides to Content Producer Author. In Author, you can then edit the slides and compile them as a Clip presentation.

To export slides to Content Producer Author

1. Do one of the following:
   - Click the Export to Content Producer Author button at the top right corner of your Editor window.
   - Select File > Export to Author.

   Content Producer Author launches, and the window displays the new slides you created in Editor:

2. Edit or enhance the new slides, or insert them in an existing Clip project in Author. Once you are finished, save the new Clip.

   - For details on working with clips, see:
     - Chapter 4, Adding Illustrative Objects to Slides, page 66
     - Chapter 5, Adding Dynamic Elements to Slides, page 85
     - Chapter 6, Working With Interactive Zones, page 111
     - For details on compiling a clip, see Chapter 9, Publishing Clip Projects, page 164.
Managing Clip Projects

This chapter describes the following topics:

- About Managing Clip Projects, page 157
- Managing Clip Files, page 157
- Adding Clips to a web site, page 159
- Exporting Slides and Audio, page 160
- Printing Slides, page 162
About Managing Clip Projects

Using Content Producer’s Author component, you can add your Clips to a web site, export audio and slides, and print slides to use as a hardcopy reference.

See:
- Managing Clip Files on page 157
- Adding Clips to a web site on page 159
- Exporting Slides and Audio on page 160
- Printing Slides on page 162

Managing Clip Files

There are two key categories of files that are saved when working with a clip project:
- the source file that contains all the screenshots, imported images, audio, etc. that make up a clip. This file is saved whenever screenshots and other clip contents have been modified. You can choose any location in which to save this file.
- the compiled clip files, a set of files used to launch and play a clip on a web browser. This set of files is saved together in a folder selected during the compilation process.

Source files

- .qvp file:
  This is the project's source file, containing all the screenshots, imported images, audio, etc., embedded into this single source file.

- .qvp.BAK file:
  This is the project's backup source file.

Compiled clip folder & files

- Clip folder and files
  During the compilation process, a folder, bearing the name of the clip project, is automatically generated to contain the project’s compiled files including an SWF file and _clip_swf.html file.

- .swf (file):
  This is the compiled Clip file (found in the Clip folder and the ZIP file) that can be played back through a browser that contains a Flash (5.0 or better) plug-in or through a Flash (5.0 or better) stand-alone player.
• **_clip_swf.html (file):**
  This is a sample HTML file created when a project is compiled. This file has the SWF embedded into it and can be used to launch the Clip in a browser instead of launching the SWF file directly.
Adding Clips to a web site

When you compile your Clip project, Content Producer places the compiled files in a folder, in a location you designated during the compilation process. The files in this folder are used to play the clip back in a browser (with a Flash 5.0 or better plug-in) or in a Flash standalone player.

Clip project files include:
- `.swf` (minimum of three files)
- `_clip.html` (single file)

You can modify `_clip_swf.html` files, which are HTML files, so that they match the look and feel of your own web site. These can be used to launch the Clip.

**Note:**
For information on editing HTML pages, or working with Web authoring tools, contact your organization’s Web specialist.

Files to Upload to the Web Server

The way in which files are imported into a web structure and uploaded to a Web server vary from web design program to program. Essentially, the files you upload to the web server, in the same folder, are:
- `.swf` (minimum of three files)
- `_clip_swf.html` (file)
- image files (if applicable)
- HTML file (web page containing the links to launch your Clips)
- the launcher.html file for uploading clips to the eLearning Lesson Management system
Exporting Slides and Audio

With Content Producer Author, you can export the slides in your project as image files or as Adobe Acrobat *.pdf document. You can also export the audio embedded in your slides into *.wav or *.mp3 files. See:

- Exporting Slides as Image Files on page 160
- Exporting Slides to an Adobe Acrobat PDF File on page 161
- Exporting Audio on page 161

Exporting Slides as Image Files

1. On the Content Producer Author menu bar, click Export > Slides to Images. The Export Slides to Images dialog box opens.

2. In the File area, do the following:
   - In the Prefix box, type the prefix name you want for all the slides you export as images.
     For example, if you type Export and complete the slide export process, once the images are generated in the destination folder you select, Export is the first part of each file name, with the number of the image appended to it. Thus, if you also select the JPG file format, the first slide becomes the image Export001.jpg, the second slide becomes image Export002.jpg, and so on.
   - In the Extension box, select the image file type option, such as the JPEG or BMP.
   - In the Quality area, select the quality you would like the image to have.

3. In the Options area, check the Slide Title and/or Within HTML Page boxes if you want the image to contain the slide title and/or appear in an HTML page. If you do not want one or both of the options, clear the appropriate check box (es).

4. Select the slides you want to export. For example, click the Current slide option or the All option.
5 Click **Export**. The **Save File In** window opens. Locate the folder in which you want to save your new files, and click **Save**. Content Producer Author automatically names the files according to the convention you selected in Step 2.

### Exporting Slides to an Adobe Acrobat PDF File

1 On the Content Producer Author menu bar, click **Export > PDF**. The **Export PDF** dialog box opens.

2 In the **Options** area, check the **Slide Title** and/or **Page Numbers** boxes if you want the slide title and/or page numbers to display in your PDF document.

3 In the **Slides** area, select the slide or range of slides that you want to export to the PDF document, or click the **All** button.

4 Click **Export**. The **Save File In** window opens. In the window, locate the folder in which you want to save your new files, and click **Save**.

### Exporting Audio

1 On the Content Producer Author menu bar, click **Export > Sounds**. The **Export Sounds** dialog box opens.

2 In the **Slides** area, select the slide or range of slides that you want to export to the PDF document, or click the **All** button.

3 Click **Export**. The **Save File In** window opens. Locate the folder in which you want to save the file, type a name for the file in the **File name** box, and click **Save**. The file is saved in *.wav format.
Printing Slides

With Content Producer, you can print the slides contained in your Clip project. This is handy for creating quick study guides, training materials, speaker notes, and much more.

See:
- Setting the page layout on page 162
- Printing Slides on page 163

Setting the page layout

Before you print slides, you need to set the output options in the Page Layout dialog.

To set the page layout:

1. Select **File > Page Layout**. The **Page Layout dialog** opens.

2. In the **Header** area, add a title and a date/time to your printouts by clicking the **Title** box, typing a title adjacent to it, and then clicking **Display date and time** boxes. Click the **Display slide border** option if you want to add a slide border in the print out.

3. In the **Layout** area, click the **Landscape** or **Portrait option**. If you want more than one slide on a page, select the number of rows of slides you want, and the number of columns of slides you want. For example, if you select 2 rows and 2 columns, four (4) slides display on a single sheet.

4. In the **Options** area, choose whether to include Hidden Slides, Slide Title, and/or the Slide Notes to printed slides. In the **Footer** area, click the **Page Numbers** option to add page numbers to the printed pages.
5 In the **Slides** area, choose whether you want to print just the current slide or a range of slides.

![](image)

- On the right side of this screen is a preview panel, which displays what the printed pages look like. You can scroll between pages using the appropriate arrows.

6 When you have set your options in the **Page Layout** dialog, click **OK** to return to your presentation, or click **Print** to go immediately to the Print window.

### Printing Slides

Once the print options for your slides are set, you can print your slides.

1 If you are already in the Page Layout screen, click **Print**. If you are in either Slide or Thumbnail View, select **File->Print** or the Print button on the toolbar. The Print window opens.

- Printer properties vary from printer to printer and are not covered in this guide.

2 Click **Print** to start the print job.
Chapter 9

Publishing Clip Projects

Once your slides are ready in your clip project, you configure the project’s property, review the clip, and then publish the clip.

This chapter contains these sections:

- About Publishing Clips, page 165
- Configuring Clip Project Properties, page 166
- Previewing a Clip, page 177
- Publishing a Clip, page 178
About Publishing Clips

When you compile and publish your clip project, Content Producer creates a folder containing a set of *.HTML or *.SWF files that allows users to launch and view the clip from a web browser.

A clip can also be uploaded to Learning Management Systems, such as eLearning Lesson Management, for use as part of a training program.

There are three stages required to compile a clip:

- Configuring Clip Project Properties on page 166
- Previewing a Clip on page 177
- Publishing a Clip on page 178
Configuring Clip Project Properties

Clip project property options allow you to customize how a clip file is generated and how it plays when users launch the clip on their browsers. You can select:

- the type of player bar
- sound and image quality
- timing for how long notes and balloons display
- to have Content Producer generate a zip file when compiling the Clip
- and more

It is also important to enter basic information about the subject of the Clip and its author. This information is embedded in the Clip.

Opening the Project Properties Dialog Box

1. To open the **Project Properties** dialog box, use one of these methods:
   - On the project toolbar, click the Project Properties button.
   - Press CTRL+M
   - On the menu bar, select **Project->Project Properties**

   The **Project Properties** dialog box opens.

2. If you have already entered the information you want in the **Project Properties** dialog box, do one of the following:
   - If you want to preview your clip, click the **Preview** button. For details see **Previewing a Clip** on page 177 for details.
3. To configure or update the Project Properties options, see Setting Project Properties options on page 167.

4. When finished working with the options in the **Project Property** dialog box, click **OK**. Alternatively, if you want to save your changes to be the default project properties, click the **Save as Default Properties** button.

**Setting Project Properties options**

There are a variety of project property options that you can configure to customize your clip project.

See:
- Entering title, author and company information on page 167
- Selecting sound and image quality options on page 168
- Setting timing options on page 169
- Setting clip options on page 170
- Setting packaging options on page 171
- Setting Flash options on page 174
- Selecting a ClipSkin on page 175
- Editing a clip’s HTML page on page 176

**Entering title, author and company information**

1. In the **Project Properties** dialog, select **Clip Profile** from the list of options.

2. On the right panel of the dialog, type a title for the Clip in the **Title** text box, and if you want, type a description in the **Description** box.

   The title appears in the Clip’s title bar when it is launched.

3. In the **Author** area, type the appropriate information in the **Name**, **Email** and **Comments** text boxes.

4. In the **Company** area, type the appropriate information in the **Company**, **Department**, and **Web Site** text boxes.

5. If you include this information when setting **Project Properties** options, users viewing the clip are able to link to the author’s email address, read the author’s comments and visit the company’s web site.

   - If you select the **Kiosk mode** option, the player bar is invisible as the Clip plays unless a user moves the mouse over the top right corner of the clip, where the player bar is located.
   - If you select the **No player bar** option, there is no player bar on the Clip, and users cannot pause/re-start or otherwise control how the Clip plays.
Selecting sound and image quality options

You can select both sound and image quality options. 
See:
- [Selecting a sound quality option](#) on page 168
- [Selecting an image quality option for the Clip](#) on page 168

**Selecting a sound quality option**

Select **Sound Quality** from the **Project Properties** list and select one of the following sound quality options displayed on the right panel of the dialog:
- **CD quality** option for the highest sound quality. It is recommended for music and subtle audio effects.
  The size of the Clip file increases considerably. Target audiences should have access to high speed internet access with sufficient bandwidth.
- **High quality** option for superior sound quality, which enables sound effects and high quality voice-overs.
  The size of the Clip file increases considerably. Target audience should have access to high speed internet access with sufficient bandwidth.
- **Standard quality** option for regular Clip voice-overs.
  The file size remains low and is acceptable for most bandwidths.
- **Strip all sounds** option to export the Clip without sound.
  Though the Clip is exported and viewed without sound, the Clip folder retains the audio files. You can export the Clip at a later date with sound by choosing another sound option and re-compiling the Clip.

Check the **Use stereo sound** box if you want to return to the default sound setting.

**Selecting an image quality option for the Clip**

Select **Image Quality** from the **Project Properties** list and select one of the following image quality options displayed on the right panel of the dialog:
- **High quality** option for showing graphic design software and high resolution images.
  The file size is largest with this option, and target audiences should have high speed internet access and adequate bandwidth to download the images.
- **Medium quality** option for all professional training, support and online help content.
  This option is suitable for all internet connections.
- **Low quality** option if you plan to reduce image quality. This option may not be suitable for professional demonstrations.
Setting timing options

1. Select **Timing** from the **Project Properties** list. The timing options display on the right panel:

   ![Timing Options](image)

   - **Minimum Message Duration** option by clicking inside the box and choose a number, for example 1 [seconds].
   - **Reading Speed** option is only applied if the **Reading Speed** option is selected and configured.

2. Set the **Minimum Message Duration** option by clicking inside the box and choose a number, for example 1 [seconds].

3. If you set the **Minimum Message Duration** option, you must set the **Reading Speed** option. Click inside the box and choose a number, for example 200 [words per minute]. The system estimates how many words could be read with the **Minimum Message Duration** option is Step 2.

4. If you want to add an introductory delay before balloons and notes appear on a slide during the presentation, in the **Introductory Delay** area, type or select the number of seconds you want for the delay.
Setting clip options

1. Select **Clip Options** from the **Project Properties** list. Login, scoring, and display options appear in the right panel.

2. If you require viewers to log on to a clip, in the **Login Options** area, check the **Require Viewers to Login** box. Then check the **Clip Password** box, and type the password viewers require to login.

3. If you want to set scoring options for your clip, in the **Scoring Options** area, do the following:
   - To set a Pass/Fail score, check the **Pass/Fail%** box, then type or select a pass/fail score in list box.
   - To set a time limit for the viewer to complete a question, check the **Time Limit** box, then type or select the hours, minutes and seconds allowed (enter hour in the first box, minutes in the second, and seconds in the third).
   - If you want to allow the viewer to repeat a question, check the **Allow Repeat** box.

4. In the **Display Options** area, select the items you want displayed on a slide. Ensure that the **Display Player Bar** box is checked, as well as the **Use hand cursor for OnClick events** box.

5. To attach a soundtrack to the background of your clip, in the **Soundtrack** area, click beside the box and when the **Sound** dialog box opens, do the following:
   - To attach an existing audio file, do the following:
     i. Click the Load Sound button beside the **Select or record a sound** box.
     ii. In the **Open** window, locate and select the audio file you want to use (these can be in such file formats as *.mp3 or *.wav).
iii. Click the **Open** button. The **Open** window closes, and the selected file name appears in the **Select or record a sound** box.

- To record a sound, do the following.
  i. Click the **Record** button and, if applicable, wait for the recording countdown to complete (for details about the countdown, see *Setting the Default Delay for Recording Sound* on page 97).
  ii. Record the sound.
  iii. When you are finished recording, click the **Stop** button. An *.mp3* file name appears in the **Select or record a sound** box. Once you save the clip project, this file is saved within the project.

Click **OK** to exit the **Sound** dialog box.

### Setting packaging options

1. Select **Packaging** from the **Project Properties** list. Executable file options are displayed on the right panel.
2 Select options as required. Option descriptions are contained in the table below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>STANDALONE PROJECTOR</strong></td>
<td>Select one of these operating system options to create an executable file. As executable files, Clips can be played on their own without a browser.</td>
</tr>
<tr>
<td><strong>CREATE AN EXECUTABLE FILE FOR:</strong></td>
<td><strong>Note 1:</strong> If you select one of these options, score functionality and links to external URLs won’t work. Also, firewalls often prevent network users from receiving executable files through email.</td>
</tr>
<tr>
<td>● Windows (.exe)</td>
<td><strong>Note 2:</strong> If you select a standalone projector option, the Send scores by email option is disabled.</td>
</tr>
<tr>
<td>● Linux (.vvl)</td>
<td></td>
</tr>
<tr>
<td>● MacOs (.hqx)</td>
<td></td>
</tr>
<tr>
<td><strong>PLAY EXECUTABLE FILE FULL SCREEN</strong></td>
<td>Select this option for full screen display of your executable Clip.</td>
</tr>
<tr>
<td><strong>CREATE A ZIP FILE</strong></td>
<td>Select to automatically create a zip file of all contents of a Clip. Zip files are compressed and easier to send via e-mail.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you linked your clip to one or more external files (not URLs), make sure to add those files manually to the Zip file. Content Producer does not include them automatically.</td>
</tr>
</tbody>
</table>
Setting Language options for the clip

1. If you want various areas within your clip, like question results or the login properties, to be shown in a different language, select Language from the Project Properties list.

2. In the Clip language area, click the arrow beside the list box, and select another language, such as French or German. Default values contained within the Login Panel, Table of Contents Panel, and Results Panel are automatically translated into another language.

3. If you want to override the default values for the selected language, scroll down to the value you want to change and replace it by typing a new value.
Setting Flash options

1. Select **Flash** from the **Project Properties** list. Various Clip display and Flash animation options are shown on the right panel.

2. In the **Size** area, you can change the default clip dimensions by typing values in the **Width** and **Height** boxes. The dimensions shown by default are those you selected when creating the Clip project (see Chapter 3, Creating and Navigating in Clip Projects, page 25).
   
   If you want to scale the dimensions to fit the Web page in which the clip opens, check the **Scale to Fit Web Page** box.

3. In the **Options** area, you can set the following options:
   
   - To compress the movie size, check the **Compress Movie** box.
   - To set the clip to play continuously, check the **Loop Mode** box.
   - To reduce users’ access to contextual menu items, check the **Reduce Flash Context Menus** box. With this option, when users right-click on a slide there are only two menu items, as shown in the following graphic:

   ![Flash Context Menus Graphic](image)

   - To set special fade effects on balloons and notes, check the **Rapid Fading on Messages** box.

4. In the **Preloader** area, to configure a preloader to play while your slides are loading, do the following:
   
   a. Check the **Display a waiting animation while the Clip is being loaded** option.
b. Select one of these options:
   - If you want the preloader to play until all the slides are loaded, select the **Wait until all slides are loaded** option.
   - If you want the preloader to play while a percentage of the slides are loaded, click **Wait for a percentage of total slides**, then type or select a percentage number in the adjacent box.
   - If you want the preloader to play until it comes to a slide you specify, select the **Wait for slide number** option then type or select a slide number from the list.

5 In the **Animated Extras** area, to add flash animation to the beginning or end of your slide, do the following:
   a. To add a Flash animation to the beginning or end of your slide, click **Beginning** and/or **End** boxes.
   b. In the **Select a Flash File** window, locate and select the file you want to use. Then click **Open**.

### Selecting a ClipSkin

1 Select **ClipSkin** from the **Project Properties** list. A drop-down list of ClipSkin options are shown on the right panel.

2 Click beside the ClipSkin list box to see a list of ClipSkin names, and select another ClipSkin. The panel refreshes to show the new look-and-feel you selected for your clip.
Editing a clip’s HTML page

A clip’s HTML page launches the clip’s Flash (*.swf) file. You can change the default HTML frame, control placement of the *.swf file, background color of the HTML page, etc.

⚠️ Before you make changes to HTML frames, files or codes, check with your system administrator and/or Web developer. Editing a project’s HTML page may affect the appearance and performance of the published clip.

1 Select **HTML Frame** from the **Project Properties** list. The right panel displays the current name of the HTML frame associated with your file, the list of files contained within the frame, and the code related to each file.

2 If you want, make one or more of the following changes:
   - In the **Select the HTML Frame that is published with your Clip** list box, select another HTML frame.
   - In the **Files** list box, select another file, add a file or delete a file.
   - In the code text box, make changes to the code of the selected file as required.

⚠️ If a different HTML frame is later selected during the clip publication process, that selection overrides any HTML frame that you select from the list box. The HTML frame selected must be compatible with the Learning Management System that you use with your published clip. For more details, see **Publishing a Clip** on page 178.
Previewing a Clip

When you finish setting the options in the Project Properties dialog, you can preview your clip.

To preview a clip

1. On the project toolbar, click the Preview in Browser button and select Preview in Browser from the drop-down menu.

2. The Preview in Browser progress box opens, indicating that the clip is being compiled. When the compilation process is complete, the preview clip opens in a browser window.

3. After you finish previewing the clip, close the browser window.
Publishing a Clip

When you compile and publish your clip, Content Producer creates a folder containing a set of files that allows users to launch and view the clip from a web browser.

To publish a clip

1. Begin the preview process in one of the following ways:
   - On the project toolbar, click the Publish Clip button.
   - On the menu bar, select Project > Publish Clip.

   The Publish Clip wizard opens:

2. If you want to store your clip in a folder not already listed in the Location box, click the Add a Local or Network Folder button. When the Select Folder window opens, browse for and select the folder in which you want to store your clip. Click Select folder. The folder is now listed in the Location box.
3 Select the folder in which you want to store your clip and click the **Next** button. The **Publish Clip - Reporting Options** dialog box opens.

![Publish Clip - Reporting Options dialog box](image)

4 Click ▼ beside the **Select a Reporting or Learning Management System** box and select one of the options shown in the table below:

<table>
<thead>
<tr>
<th>Reporting or Learning Management System option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Select this option if you do not need to have your clip tracked in any learning management system.</td>
</tr>
<tr>
<td>Verint Systems Email Reporting System</td>
<td>Select this option if you want a report of on the interactions with dynamic learning objects in your clip to be sent to the Verint Systems e-mail reporting system.</td>
</tr>
<tr>
<td>SCORM 2004 Learning Management System</td>
<td>Select this option to track dynamic learning objects used by Learning Management Systems compatible with SCORM 2004.</td>
</tr>
<tr>
<td>SCORM 1.2 Learning Management System</td>
<td>Select this option to track dynamic learning objects used by Learning Management Systems. Note that Content Producer has passed the ADL SCORM version 1.2 Test Suite, and conforms fully with SCORM 1.2 specifications.</td>
</tr>
<tr>
<td>AICC Learning Management System</td>
<td>Select this option to track dynamic learning objects used by the Impact 360 eLearning Management System.</td>
</tr>
</tbody>
</table>
Once you select a reporting option, the default HTML frame associated with the option is shown selected in the **HTML Frame** area.

⚠️ Once you select a reporting option, it is not recommended that you change the default HTML frame. If you do, the clip you publish may not work with the selected option. Consult your system administrator or web programmer for more information.

5 The next screen opens, showing the compilation’s progress.

![Compilation Screen](image)

6 Once the compilation finishes, the screen refreshes, showing the clip’s URL.

![Clip URL Screen](image)

7 If you want to launch the clip, click the **View** button.

8 If you want to view the contents of the clip folder, click the **Browse** button.
Click **Finish** to complete the publishing process and to exit the wizard. Users can now launch your clip from the location you designated during the compilation process.
Learning clips published using Content Producer Author can be uploaded to the Impact 360 eLearning Lesson Management system as lesson content.

This chapter contains the following sections:

- **Uploading Lesson Content to the eLearning Lesson Management System, page 183**
- **Selecting the AICC Learning Management System reporting option in Content Producer Author, page 184**
- **Uploading Clips to the eLearning Lesson Management System, page 185**
- **Student Procedures, page 188**
Uploading Lesson Content to the eLearning Lesson Management System

If your Impact 360 enterprise solution includes the eLearning Lesson Management system, you can upload clips to eLearning and automatically deliver them as scored or non-scored lessons.

Before you upload Content Producer clips to the eLearning Lesson Management system, configure your Content Producer clip to use the AICC learning management system option.

See:
- Selecting the AICC Learning Management System reporting option in Content Producer Author on page 184
- Uploading Clips to the eLearning Lesson Management System on page 185
Selecting the AICC Learning Management System reporting option in Content Producer Author

In order to be able to upload a Content Producer clip in the eLearning Lesson Management system, ensure that when you publish your Content Producer clip, you select the **AICC Learning Management System** reporting option.

To select the **AICC Learning Management System** reporting option:

1. Open the clip project you want to upload to Lesson Management.
2. On Content Producer Author’s menu bar, click Project > Publish Clip.
3. Select the folder in which you want to store your clip and click the Next button. The Publish Clip - Reporting Options dialog box opens.

4. Click beside the Select a Reporting or Learning Management System list box and select the **AICC Learning Management System** option. Once you select the option, the associated default HTML frame is shown in the HTML Frame area.

5. Complete the clip publishing process as described in Chapter 9, Publishing Clip Projects, page 164. Your Clip files will be saved inside a clip folder.

6. Once your clip folder has been generated, save the folder in a *.zip file. You use the zip file to upload the clip to the eLearning Lesson Management system.
Uploading Clips to the eLearning Lesson Management System

You may need to upload lesson content from files in your own directory or a remote machine. When you complete the following procedure, the files are copied to the eLearning server.

See:
- Starting eLearning on page 185
- Configuring Lesson Settings on page 185
- Uploading lesson content on page 186

Starting eLearning

Launch and log on to the Impact 360 suite. In the main window, click the **Learning** tab to open the eLearning module, and then click the **Lessons** tab, and the **Topics** sub tab.

For details on accessing eLearning, see the *eLearning Administration User Guide*, Chapter 2, "Launching and Navigating in eLearning". This guide can be found on the installation DVDs you received with the product suite.

Configuring Lesson Settings

1. In the Impact 360 suite main window, navigate to **Learning > Lessons > Settings**.
2. Configure lesson settings as described in the *eLearning Administrator User Guide*, Chapter 5, "Managing Lessons", section Configuring Lesson Settings. While configuring the lesson settings in the **Lesson Details** form, insure the following:
   - Select a lesson type option that you can use with Content Producer clips. Click the arrow icon beside the **Lesson Type** box and from the drop-down list, select a lesson type option. The options available are:
     - **Content Producer - Scored** - Lessons created with the Content Producer application that have scores associated with them.
     - **Content Producer - Not scored** - Lessons created with the Content Producer application that do not have scores associated with them.
3. To save the lesson settings, click the **Apply** button, and go to the procedure Uploading lesson content, page 186.
Uploading lesson content

Make sure that your Producer clip folder has been saved in a zip file.

Make sure that prior to uploading content, you select the **Content Producer - Scored** or **Content Producer - Not Scored** lesson type option in the **Lesson Type** drop-down box.

1. Configure and apply lesson settings as described in the procedure **Configuring Lesson Settings, page 185**. Once a new lesson’s settings have been applied, the **Upload Content** button at the bottom right of the **Lesson Details** window is enabled. Click the **Upload Content** button. The **Upload Lesson Content File** pop-up box opens:

2. Click the **Browse** button, and then locate and select the zip file that contains the clip you want to upload.

3. Click the **Upload** button. Once the file has been uploaded, the pop-up box closes and the **Lesson Details** form refreshes. Note that the launch file name of your clip
(a file name ending with \textit{\_launcher.html}) is automatically inserted in the \textbf{Lesson Location} box after the content upload is complete.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{figure10}
\caption{Example of Lesson Details window.}
\end{figure}

\textbullet If you define an incorrect location or file name for a lesson, you cannot test launch the lesson nor can you save the lesson. If the location is incorrect and you attempt to save the lesson, a warning in red at the top of the \textbf{Lesson Details} window indicates that the location is incorrect.

4 To confirm that the lesson you uploaded launches correctly, click the \textbf{Launch Content} button at the bottom of the window. The lesson launches in a separate window. Close the window when you are finished reviewing the lesson content.

5 Click the \textbf{Save} button. You can now include the lesson in a lesson block, or assign the lesson to the appropriate organizations, groups, or individuals. For more details, see the \textit{eLearning Administration User Guide}.
Student Procedures

The eLearning Student pages are located in the Impact 360 suite as part of the eLearning module. eLearning Student provides online access to lessons, restarting and resuming lessons, and viewing detailed information about lessons already taken. See:

- Starting eLearning Student on page 188
- Taking a lesson on page 188.

Starting eLearning Student

Launch and log on to the Impact 360 suite with an agent user name and password. In the main window, click the My Home tab, and then click the My Learning tab to open the eLearning Student pages.

For details on accessing eLearning, see the eLearning Administration User Guide, Chapter 2, "Launching and Navigating in eLearning". This guide can be found on the installation DVDs you received with the product suite.

Taking a lesson

1. In the Impact 360 suite window, click the My Home tab and then click the My Learning tab.
2. Click the Current Assignments or Learning History sub-tab.
If the user only has an Agent’s role, the My Home tab does not appear on the screen, only the module’s sub-tabs, such as My Learning.

3 Select a lesson and click the **Start Lesson** button at the bottom of the screen. When a lesson starts, the eLearning system launches it on the student’s desktop. When a lesson ends, the system displays the statistical information for the lesson. Depending on how your organization has configured the eLearning Lesson Management system, these statistical details can include your lesson score, number of lesson attempts, competency score, and more.

For more information about using the Student pages, see the eLearning Student User Guide, located on your product installation DVD.